Plan-G User Manual Version 2.05 March 2011
# CONTENTS

1 INTRODUCTION ............................................................................................................ 1  
2 FEATURES.................................................................................................................. 2  
3 PREREQUISITES........................................................................................................... 3  
4 INSTALLATION ........................................................................................................... 4  
5 FIRST RUN .................................................................................................................. 6 
  5.1 Single PC ............................................................................................................... 6  
  5.2 Networked PCs ....................................................................................................... 6  
  5.3 Has it Worked? ......................................................................................................... 6  
6 HAVE A LOOK AROUND .............................................................................................. 7 
  6.1 Google Maps Options .............................................................................................. 7  
  6.2 The Quick Access Toolbar ...................................................................................... 7  
  6.3 The Ribbon Menu Tabs ........................................................................................... 8  
  6.4 The Main Window ................................................................................................... 9  
  6.5 The Overview Map ................................................................................................ 9  
  6.6 The Expander Panel ................................................................................................ 9  
  6.7 Tool Tips ................................................................................................................ 9  
7 THE RIBBON MENU TABS ............................................................................................ 10 
  7.1 The File Tab .......................................................................................................... 10  
  7.2 The Home Tab ....................................................................................................... 10  
  7.3 The Map Tab ......................................................................................................... 10  
  7.4 The Data Tab ......................................................................................................... 11  
  7.5 The View Tab ........................................................................................................ 11  
  7.6 Ribbon Auto-Hide .................................................................................................. 12  
8 THE FILE MENU IN DETAIL ......................................................................................... 13 
  8.1 New ....................................................................................................................... 13  
  8.2 Open ....................................................................................................................... 13  
  8.3 Save As ................................................................................................................... 13  
  8.4 Help ....................................................................................................................... 14  
  8.5 Options .................................................................................................................. 14  
  8.5.1 Locations ......................................................................................................... 15  
  8.5.2 Units ................................................................................................................ 19
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.5.3</td>
<td>Sounds</td>
<td>19</td>
</tr>
<tr>
<td>8.5.4</td>
<td>FS Connections</td>
<td>20</td>
</tr>
<tr>
<td>8.5.5</td>
<td>The GPS Panel</td>
<td>21</td>
</tr>
<tr>
<td>8.5.6</td>
<td>User Aircraft</td>
<td>22</td>
</tr>
<tr>
<td>8.5.7</td>
<td>Traffic</td>
<td>23</td>
</tr>
<tr>
<td>8.5.8</td>
<td>Weather</td>
<td>24</td>
</tr>
<tr>
<td>9</td>
<td>THE HOME RIBBON IN DETAIL</td>
<td>25</td>
</tr>
<tr>
<td>9.1</td>
<td>Find</td>
<td>25</td>
</tr>
<tr>
<td>9.2</td>
<td>Print</td>
<td>26</td>
</tr>
<tr>
<td>9.3</td>
<td>Start Position</td>
<td>26</td>
</tr>
<tr>
<td>9.4</td>
<td>Altitude</td>
<td>27</td>
</tr>
<tr>
<td>9.5</td>
<td>Airspeed</td>
<td>27</td>
</tr>
<tr>
<td>9.6</td>
<td>Winds</td>
<td>27</td>
</tr>
<tr>
<td>9.7</td>
<td>VFR/IFR</td>
<td>27</td>
</tr>
<tr>
<td>9.8</td>
<td>Quick</td>
<td>27</td>
</tr>
<tr>
<td>9.9</td>
<td>Reverse</td>
<td>28</td>
</tr>
<tr>
<td>9.10</td>
<td>The Edit Button</td>
<td>28</td>
</tr>
<tr>
<td>9.11</td>
<td>The Frame Button</td>
<td>28</td>
</tr>
<tr>
<td>9.12</td>
<td>Copy Route</td>
<td>28</td>
</tr>
<tr>
<td>9.13</td>
<td>Range Rings</td>
<td>28</td>
</tr>
<tr>
<td>9.14</td>
<td>Bookmark</td>
<td>28</td>
</tr>
<tr>
<td>9.15</td>
<td>KML</td>
<td>29</td>
</tr>
<tr>
<td>9.16</td>
<td>Connect/Disconnect</td>
<td>30</td>
</tr>
<tr>
<td>9.17</td>
<td>Map Panning Control</td>
<td>30</td>
</tr>
<tr>
<td>10</td>
<td>THE MAP RIBBON IN DETAIL</td>
<td>31</td>
</tr>
<tr>
<td>10.1</td>
<td>User Configured Settings</td>
<td>31</td>
</tr>
<tr>
<td>10.2</td>
<td>Reset Display Defaults</td>
<td>31</td>
</tr>
<tr>
<td>10.3</td>
<td>Airports</td>
<td>32</td>
</tr>
<tr>
<td>10.4</td>
<td>Navaids</td>
<td>32</td>
</tr>
<tr>
<td>10.5</td>
<td>Airspace</td>
<td>34</td>
</tr>
<tr>
<td>10.6</td>
<td>User Waypoints</td>
<td>35</td>
</tr>
<tr>
<td>10.7</td>
<td>Reset Defaults</td>
<td>35</td>
</tr>
<tr>
<td>10.8</td>
<td>Fix Overlays</td>
<td>35</td>
</tr>
</tbody>
</table>
11 THE DATA RIBBON IN DETAIL ........................................................................ 36
12 THE VIEW RIBBON IN DETAIL ................................................................. 37
  12.1 Plan Elevation Tick box ........................................................................ 37
  12.2 Map Graticule .................................................................................... 38
  12.3 Map Overlays .................................................................................... 38
  12.4 Expander Icon .................................................................................. 38
  12.5 Alternative Zoom Controls ................................................................. 39
  12.6 Keep Window on Top ........................................................................ 39
13 THE DATA EXPANDERS ............................................................................ 40
  13.1 Plan .................................................................................................... 40
  13.2 Weather ............................................................................................ 41
  13.3 GPS Panel ........................................................................................ 41
  13.4 A Special HSI ...................................................................................... 42
    13.4.1 The Wind Arrow .......................................................................... 42
    13.4.2 Direction Indicator ....................................................................... 42
    13.4.3 Course Deviation Indicator ......................................................... 43
    13.4.4 Automatic Direction Finder ......................................................... 43
    13.4.5 Descent Profile Indicator ............................................................. 43
  13.5 Traffic .................................................................................................. 43
  13.6 Trail Analysis ...................................................................................... 44
  13.7 Aerodrome ........................................................................................ 45
  13.8 Information ........................................................................................ 45
14 CONTEXT MENU OPTIONS ......................................................................... 47
  14.1 Right-Click on the Map ........................................................................ 47
    14.1.1 Create User Waypoint .................................................................... 47
    14.1.2 Spot Elevation .............................................................................. 47
    14.1.3 Display and Hide Range Rings ..................................................... 47
    14.1.4 QDM Range and Bearing ............................................................. 48
    14.1.5 Lock Info Panel ............................................................................. 49
  14.2 Right Click on an Airport ..................................................................... 49
    14.2.1 Start Flight Plan at Airport ............................................................ 49
    14.2.2 Select Airport as Alternate .......................................................... 50
    14.2.3 Show Airport Chart ................................................................. 50
14.2.4 Instrument Approaches .......................................................... 50
14.2.5 METAR ............................................................................. 51
14.2.6 Other Selections ................................................................. 51
14.3 Right-Click on the ‘Plan’ Expander ............................................ 52
14.3.1 Set This as the Active Leg ................................................... 52
14.3.2 Centre on Map .................................................................. 52
14.3.3 Move or Delete Waypoint .................................................... 52
14.3.4 Cross References ............................................................... 52
14.3.5 Add Alternate ..................................................................... 54
14.3.6 Set Author ......................................................................... 54
15 FLIGHT PLANS ......................................................................... 55
15.1 Creating a Flight Plan Graphically ............................................ 55
15.1.1 New Flight Plan .................................................................. 55
15.1.2 Flight Conditions ............................................................... 55
15.1.3 Departure Airport .............................................................. 55
15.1.4 Continue to Add Waypoints ............................................... 56
15.1.5 Start Position ..................................................................... 57
15.1.6 Vertical Navigation ............................................................ 58
15.1.7 Notes ................................................................................ 58
15.1.8 Save your Plan ................................................................. 58
15.1.9 The Reverse Button ........................................................... 58
15.2 Creating a Flight Plan by Data Entry ......................................... 58
15.2.1 Inserting Waypoints into the Tabular Plan ......................... 58
15.2.2 Notes ............................................................................... 59
15.2.3 Save Your Plan .................................................................. 59
15.3 Vertical Navigation ................................................................. 59
15.3.1 User Defined VNAV Profile ............................................... 59
15.3.2 Default VNAV Profile ......................................................... 60
15.4 Modifying Existing Flight Plans ............................................... 60
15.4.1 Adding a New Waypoint to the End of a Plan ...................... 61
15.4.2 Inserting a New Waypoint .................................................. 61
15.4.3 Inserting a Waypoint into the Tabular Plan ......................... 61
15.4.4 Moving and Deleting Waypoints ......................................... 61
15.4.5 Save Your Edited Plan ..............................................................62
15.5 Using the ‘Edit’ Button .................................................................62

16 User Waypoints .................................................................................64
16.1 Creating User Waypoints ...............................................................64
16.2 Adding a New User Waypoint to the Flight Plan ..........................66
16.3 Modifying User Waypoints .............................................................66
16.4 Deleting User Waypoints ...............................................................67
16.5 Managing the User Waypoint Database .......................................67
16.6 Importing and Exporting Records ...............................................68

17 AN EXAMPLE FLIGHT PLAN ..............................................................69
17.1 Preparation ....................................................................................69
17.2 The Scenic Route ..........................................................................70
17.3 A Little Stick of Blackpool Rock ....................................................72
17.4 Controlled Airspace .......................................................................73
17.5 VNAV Profile ................................................................................75
17.6 Notes .............................................................................................76
17.7 Alternate .........................................................................................76
17.8 Let’s Go Flying ................................................................................77

18 CONNECTION TO FLIGHT SIMULATOR ............................................79
18.1 Flight Data Transfer .......................................................................79
18.2 Communication Protocols ..............................................................80

19 FLIGHT SIMULATOR AND PLAN-G ON THE SAME COMPUTER ....82
19.1 Connecting to FS9 ..........................................................................82
19.2 Connecting to FSX with SimConnect .............................................83
19.2.1 Connection Using Pipe ..............................................................84
19.2.2 Connection Using IPv4 ..............................................................84
19.2.3 Connection Using IPv6 ..............................................................85
19.3 Connecting to FSX with FSUIPC ....................................................86

20 FLIGHT SIMULATOR AND PLAN-G ON A NETWORK ....................88
20.1 First Find Your Sim .......................................................................88
20.2 Connecting to FS9 from a Networked PC .......................................88
20.2.1 WideFS ....................................................................................89
20.2.2 Connection Steps .......................................................................89
20.3 Connecting to FSX from a Networked PC with SimConnect .................90
  20.3.1 Creating a SimConnect.xml file for the IPv4 Protocol.................90
  20.3.2 Creating a SimConnect.xml file for the IPv6 Protocol.................91
  20.3.3 Modifying an Existing a SimConnect.xml file............................93
  20.3.4 Configure the SimConnect Settings in Plan-G............................93
  20.3.5 Connected ..................................................................................95

20.4 Connecting to FSX from a Networked PC with FSUIPC ..................95
  20.4.1 WideFS......................................................................................96
  20.4.2 Connection Steps.........................................................................96

21 MORE ON SIMCONNECT............................................................................98
  21.1 Example 1.......................................................................................99
  21.2 Example 2......................................................................................100

22 APPENDICES..........................................................................................102
  22.1 Appendix 1 Table of Illustrations..................................................102
  22.2 Appendix 2 - Support ..................................................................105
  22.3 Appendix 3 - Solve the Script Error Issue....................................105
  22.4 Appendix 4 - List of Beta Testers.................................................106
1 INTRODUCTION

Plan-G is the first Flight Simulator planning software tool to use the acclaimed and versatile Google Maps mapping tool. Hitherto, the inbuilt planner and third party external flight planners have extrapolated geographic data from the Simulator program itself, with the limitation which that entails. Now, any geographical feature which exists in the vast global mapping system of Google Maps can be included in your flight plans.

Plan-G adds overlays to Google Maps pertinent to Flight and Flight Planning – Airports, Controlled Airspace, Prohibited and Restricted Areas, Instrument Approach Paths and many more.

Flight Plans can be graphically modified; adding, deleting or dragging waypoints to new positions with the mouse. User defined waypoints can be created “on the fly” as you build a plan.

Plan-G runs as a web-style application using its own inbuilt Internet Explorer browser.
2 FEATURES

- Google Maps interface for rich topographical and satellite detail
- Shows airspace, airports and navaids on the map (from Flight Sim data)
- Configurable levels of detail (objects displayed) for each zoom setting
- Vertical Route (requires additional Digital Elevation Model (DEM) download)
- Fully editable plans can be saved in FSX or FS9 format or in Plan-G’s own format
- Existing FS plans can be loaded
- Flight plans can be reversed at the click of the mouse
- Flight Plans can be annotated, and waypoints cross referenced to ground-based radio navaids.
- Either map or Pilot’s Log (PLOG), or both, can be printed
- Customisable database of user waypoints, Visual Reference Points (VRPs), airstrips etc. Many useful waypoints are included in the download.
- Additional User Waypoint comma separated text files can be imported.
- Synchronised connection to FSX or FS9
- Aircraft telemetry, aircraft flight trails, traffic, weather etc available when connected to FSX or FS9
- Saved flight trails can be displayed for later analysis
- Configurable Range Rings can show distance or flight time
- Display instrument approaches and low altitude airways
- Display current weather for known weather stations in TAF and METAR format even if not connected to FS
- Overlay Google KML/KMZ files
- Can be run on a second monitor or on a networked PC.
3 PREREQUISITES

To function, Plan-G requires that .Net 4.0 Client Profile be installed on the user’s PC. If it isn’t installed on your PC, it is downloaded automatically by the installation program, and the user doesn’t need to take any action.

Plan-G also requires an active Internet connection to function.
4 INSTALLATION

Installing Plan-G is simplicity itself. Download the latest version from the TA Software Forum http://www.tasoftware.co.uk/forum. Unzip the downloaded zip file to a temporary folder of your choice. Three files will be extracted: setup.exe, setup.msi and a ReadMe.txt file. Run the file setup.exe by double clicking the filename. This will install Plan-G in a folder within the standard Program Files system of Windows, e.g. C:\Program Files\TA Software\Plan-G

When installation is complete, the familiar “yellow aeroplane” icon will be placed on your desktop, which when clicked, will launch the application.

![Figure 1 The Plan-G User Interface at Startup](image)

If you have installed version 0.9 of this software, you can either delete the previous version folder completely, or you can if you wish leave it on your PC, as it will not cause Version 2.0 and later to malfunction.

To uninstall Plan-G from Version 2.0 onwards, you need to uninstall it from the Windows Control Panel, (In Windows XP: Add/Remove Programs, in Vista and Windows 7: Programs/Uninstall a program). Normally it will also be necessary to uninstall previous versions before installing an updated one. The Readme file included with the download contains an appropriate warning if this is needed.

The separate addon waypoint packs available for Version 0.9 have been expanded and included in Version 2.0, so there is no need to reimport them into the User Waypoint Database.

If you have created user waypoints in an earlier version of Plan-G that you want to keep, then because of structural and content changes in the database from earlier versions,
you must export them to a CSV file, (see Section 16.6) **BEFORE** installing the new version of Plan-G, then re-import them once you have installed the new release.

**Useful Tip:** Why not keep a backup of your User Waypoints as a CSV file anyway, in a separate folder from Plan-G to avoid it being accidentally overwritten when you install a new version? You could make it part of your normal backup routine, which of course you have!

With each new version, you will need to rebuild the main database. A warning message to this effect appears when you first start Plan-G. However, many other settings are retained between versions, such as the locations of the important files Plan-G needs to access, (See Section 8.5.1) so there is no need to re-enter them.
5 FIRST RUN

The first time you run Plan-G you will be prompted to build its internal database. Once the database has been created you can explore at leisure.

5.1 Single PC

To build the internal database with Plan-G and FS on the same computer, go to the Data menu and click on the Build FSX or Build FS9 icon. If you have both FS9 and FSX installed, you must build the database for both Sims separately. You can then switch between them and Plan-G will load the correct dataset.

![Figure 2 Database Build Options](image)

In the example shown above, only FSX is installed on that PC.

5.2 Networked PCs

If FSX or FS9 is installed on a separate, networked, computer to Plan-G, you must first follow the instructions in Section 8.5.1 below to set up the locations in Plan-G so that it knows where to get its Flight Simulator data. Once you have done this, Plan-G will be able to find the data it needs to build the database for the appropriate sim. You can even have FSX on one PC, FS9 on another, and Plan-G on a third. As long as the locations are set correctly, Plan-G will build the databases.

Building the databases is not the same as connecting Plan-G to your sim. To connect FS to Plan-G follow the instructions in section 20 - “Flight Simulator and Plan-G on Separate Computers”. However, you must have first set the locations otherwise when you try to connect FS to Plan-G, you will get an error message.

5.3 Has it Worked?

Occasionally Plan-G will appear to build the database very quickly. This usually means that the build has failed, and you will have to build the database again. You can quickly check whether a database exists, because any current databases available are indicated by the relevant database icon being a strong colour; blue for FSX; grey for FS9. If either sim is not installed, then the database icon for that sim will be a pale blue (for FSX) or a pale grey for FS9.
6 HAVE A LOOK AROUND

Most of the screen is occupied by a map. If you have used Google maps before it will be quite familiar. Top left are the Google Maps pan and zoom tools and top right the usual Google maps options.

6.1 Google Maps Options

<table>
<thead>
<tr>
<th>Map</th>
<th>Satellite</th>
<th>Hybrid</th>
<th>Terrain</th>
<th>Earth</th>
</tr>
</thead>
</table>

*Figure 3 The Standard Google Maps Tools are used*

**Map**

This displays roads, rivers and street names if you zoom in far enough etc.

**Satellite**

Obviously this displays satellite photographs of the whole earth, although as you zoom in, the level of detail available varies widely. In the UK, you can easily identify individual buildings.

**Hybrid**

Street names and town names are overlaid on the basic satellite views.

**Terrain**

This view is probably the most useful for FS pilots as terrain clearance and identification of high ground is important. Towns, roads, rivers lakes etc., are shown minimally. Contours are shown at 200 metre intervals.

**Earth**

If you already have Google Earth installed on your PC, then it can be accessed from this option. If you do not have Google Earth installed, then clicking this option displays a prompt to install the Google Earth Plugin.

6.2 The Quick Access Toolbar

By default, this toolbar contains three items. However, ANY button on any of the ribbons can be added to the Quick Access Toolbar by right-clicking and selecting ‘Add to Quick Access Toolbar’

*Figure 4 Quick Access Toolbar*

The default icons are, from the left:

The “Yellow Aeroplane” icon – moves, resizes, minimises or maximises the whole Plan-G window.
The “Blank Page” icon – clears any elements of a flight plan in memory, allowing a fresh start.

The “Down Arrow” Icon – clicking this icon displays a small dropdown menu with six options. In the picture below, an additional option, Save Flight Plan has been selected as well as the default, and the relevant icon is shown on the Quick Access Toolbar.

Figure 5 The ‘Customise Quick Access Toolbar’ Dropdown

In addition to the five Quick Access Toolbar options, the Quick Access Toolbar itself can be shown below the ribbon rather than above it. When the Quick Access Toolbar is below the ribbon, the final item on the dropdown changes to “Show above the Ribbon”, as you might expect.

The ribbon bar can be minimised by double clicking on one of the four ribbon tabs (“Home”, “Map”, “Data” & “View”). To restore the ribbon bar, double click again any of the ribbon tabs.

The “File” tab is a special case. Double clicking only opens and closes the file screen. In this and in other ways, it functions differently from the other tabs.

The ribbon bar functions are not needed at all times, so minimizing the ribbon does not necessarily reduce your options, but can free valuable screen space.

The ribbons can also be “auto-hidden”. At the far right hand end of each ribbon is a small arrow icon which when clicked hides not only the current ribbon, but the whole ribbon system. When you click one of the Menu tabs, the ribbon is displayed until you click on the map or expander area, when it is automatically hidden again.

6.3 The Ribbon Menu Tabs

There are five Tabs, each of which when clicked, reveals its own Ribbon Menu (except “File” which opens a page with a sidebar menu).

Figure 6 The Menu Tabs

The ribbon menus control almost all the functions of Plan-G.
6.4 **The Main Window**
When Plan-G starts, the main window displays a Google map of the location where you were when you last exited the program, and at the same magnification. Features are displayed in accordance with the user defined options on the Map ribbon.

6.5 **The Overview Map**
At the bottom right of the main screen there is a small overview map with a moveable rectangular highlight. As you mouse-drag the highlight about, the main map display follows in synchronization. This provides a quick method of adjusting the area viewed. It can be minimized by clicking the launcher button (the small diagonal arrow box) in the bottom right hand corner.

6.6 **The Expander Panel**
This panel provides information on a range of topics:
- **Plan:** The tabular Plan itself,
- **Weather:** When connected to FS shows the FS weather for the nearest weather station to the aircraft, and the en route weather. This FS weather may of course be external real weather, depending on the source being used by FS itself.
- **GPS Panel:** Displays five of the standard “six-pack” flight instruments which are fitted directly in front of the pilot in most modern aircraft before the advent of “glass cockpits”. The missing one is the Attitude indicator.
- **Trail:** Displays user selectable previous flights as a trace across the map,
- **Aerodrome:** If you right-click an airport on the map and select “Show Airport Chart” from the drop-down. The aerodrome chart, runways and taxiways is displayed beneath the Aerodrome tag.
- **Information:** Displays textual data about controlled airspace and other details.

Once the database has been built, the default view shows the menu options on the Home tab.

6.7 **Tool Tips**
If you hover the mouse over any symbol, menu option, tick box, radio button or aeronautical feature on the map, (or any of the Google Maps tools), a context sensitive tooltip is displayed briefly describing the item’s function or identity.

Of course, many are obvious, but it surprising how useful they can be when your mind goes blank (as it will sometimes, fear not!).
7 THE RIBBON MENU TABS

7.1 The File Tab

If you click the “File” tab, then various file handling and setup functions are available.

The default view is of the Open function, with, on the right, a list of eight of the most recent flight plans opened, but with links also to where all the plans are stored, My documents\Flight Simulator for FS9, or My Documents\ Flight Simulator X Files. A red cross icon on the right of each of the eight most recent flight plans will delete that entry from the list, but it does not delete the flight plan itself.

7.2 The Home Tab

Selecting the Home Tab displays the Home ribbon, which contains a significant number of options described fully in section 9 below.

7.3 The Map Tab

Selecting the Map Tab displays the Map ribbon, which shows the items which are displayed as standard at each scale (level of zoom) of the map. It is user configurable, but the more detail displayed at the lower zoom levels (more map displayed) the more cluttered the display will be and the slower to load and refresh following changes. If the user selects too much data to be displayed, Plan-G can sometimes display an error message.

The map settings are described in more detail in section 10.
7.4 The Data Tab

The Data Tab displays the Data Ribbon which allows you to

- Create the database for either FS9 or FSX, and
- Select which simulator version displays on the map and for which you wish to create a plan.
- Manage the User Waypoint database.

These options are of course only available for the simulator version(s) you have installed.

Any current databases available are indicated by the relevant icon being a strong colour; blue for FSX; grey for FS9. The icons are shown in the same colours, but faded if a database is unavailable for that simulator version. Whichever simulator version is running is shown with an orange background.

7.5 The View Tab

The view tab displays options to customize some elements of what you see on screen. Map overlays and the map graticule can be switched off to improve clarity and speed map refresh rate, for example. There are also three customisable fixed zoom buttons for quickly selecting a favourite zoom ratio. On smaller screens, not all the data expanders can be displayed, and data at the bottom, such as airport details, sometimes falls off the bottom of the screen. Customising the expanders you wish to hide or display can help in this respect.
7.6 **Ribbon Auto-Hide**

At the far right hand end of each ribbon is a small arrow icon which when clicked hides the ribbon (whichever ribbon you are viewing at the time). It hides the whole ribbon system, not just the one you are currently viewing. When you click one of the Menu tabs, the associated ribbon is displayed until you click on the map or expander area, when it is automatically hidden again. A hot key combination, Ctrl-F1, is also available, which toggles hidden or displayed mode.

If Auto-hide is enabled, the ribbon is “auto-hidden” in this way on first installation.

![Figure 12 The ‘Minimise Ribbon’ icon and Tooltip](image)

Double-clicking any of the tabs will also auto-hide the ribbon. Double-clicking a tab again will display the relevant ribbon and switch off the auto-hide feature.
8 THE FILE MENU IN DETAIL

This isn’t a strictly a ribbon, but a page with a vertical sidebar menu. The page default function is to display the last eight flight plans created or opened. Any of these eight can be deleted by clicking on the red cross symbol to the right. That will delete that entry from the list, but does not delete the flight plan itself. The side bar menu options are described in detail below.

8.1 New

Selecting “New” closes the menu and returns the user to the main map window, where a new plan can be created as described in Section 15 below.

8.2 Open

Selecting the “open” option initially does nothing, because, as it is the default “File” page as mentioned above, it is already effectively selected. The user can select a recently created or opened flight plan from the list, or select a .PLN or .PLG file by clicking on the appropriate browser link at the bottom of the page. Clicking the link opens, by default, the Flight Simulator Files folder (for FS9 users) or Flight Simulator X Files folder, located in “My Documents” (Windows XP) or simply “Documents” in Windows Vista or Windows 7.

Depending on which “Browse for existing files” link you have selected, the window opens with only the .PLN, or .PLG files shown. You can switch to the other file type from within that selection window if you got it wrong initially, as there is a selection box in the lower right border area above the “Open” button.

If you store flight plans at some other location, you can navigate the file browser there, using the usual Windows methods depending on your Operating System. Plan-G "remembers" where you saved the most recent saved FS9 and/or FSX flight plans, and will open the file browser at that folder, so you can select a previously created flight plan from there.

Once the flight plan is loaded, Plan-G will change its map location and display the legs and the waypoints of the whole of your selected flight plan.

8.3 Save As

The “Save As” option allows you to choose whether to save the plan as an FS9 flight plan (.pln file); an FSX flight plan (.pln file); or as a Plan-G extended flight plan format (.plg) file, or to save a plan with a different name. Plan-G specific features (passing altitudes, notes, cross-references etc) are not saved in .PLN files. You must save a .PLG if you wish to preserve this extra information. However, Plan-G format files cannot be used in the FS Flight Planner or the built in FS/Garmin GPS units.

Note: that the FS9 flight planning tool treats user waypoints as intersections. Although user waypoints can be added to FS9 flight plans in Plan-G, they cannot be added directly to a flight plan within FS9.
8.4 Help

The first option on the Help page provides information about the current build of the program and the last gives the user the opportunity to automatically check for updates to his current version.

The second option opens the Adobe Acrobat format Plan-G User Manual (this document). If you can't find what you are looking for there, then the third option is a link to the TASoftware forum, where all the experts, including Tim Arnot, the Plan-G creator, are ready and eager to solve your problem.

8.5 Options

Selecting “Options” opens an Options window, with a second sidebar menu which gives access to nine different dialogue panes. When you open Plan-G, the first time you visit the “File/Options” menu selection, the right hand area of the page is blank, and remains so, unless you select one of the nine options. Plan-G keeps open the last selected pane for the duration of the Plan-G session.

The options panes are reasonably self explanatory. Default values are included which can help decide appropriate values (AI aircraft refresh rate of 600 (seconds) isn't going to be terribly useful for example.

You may not wish to change the defaults, but when things get busy, for example, you can de-clutter the screen by switching off AI, or parked aircraft, or limit the range within which they are shown. If you want to see your own aircraft when Plan-G is connected to Flight Simulator you clearly have to have the first box ticked in “User Aircraft”, but there
may be occasions when you only want to see everyone else. This element of Plan-G allows you to choose.

The nine options are:

- Locations
- Units
- Sounds
- FS Connections
- GPS Panel
- User Aircraft
- Traffic
- Weather
- General

The options are described in detail below.

8.5.1 **Locations**

**A) Single Computer**

The Locations menu option allows Plan-G to locate the FS files it requires in order to build its internal database of airports and navaids, and to communicate with a running instance of Flight Simulator on either the same computer or a networked PC running FS.

![Figure 14 The Locations Page](image-url)
The two directories Plan-G needs to “know about” are:

The main FS directory, (by default, C:\Program Files\Microsoft Games\(FS9 or FSX), but often changed by FS users during FS installation, e.g. E:\FSX shown in Figure 15 above).

The directory containing FS’s scenery configuration file (scenery.cfg).

For Windows XP users, this is usually

\( C:\{Documents\ and\ Settings\}<user\ name>\{Application\ Data\}<Microsoft\FSX\)

For Windows Vista and Windows 7 users, this is usually

\( C:\\{Program\ Data\}<Microsoft\FSX\).

In most cases, these directories will be in these “default” locations, and Plan-G will be able to automatically locate the correct location, but if your FS installation differs from the default, you may need to point Plan-G at the correct locations on your FS PC.

The scenery configuration file \( C:\\{ProgramData\<Microsoft\FSX\scenery.cfg\) links Plan-G to the default scenery and any third party airstrip scenery you have installed.

Make sure you have set your scenery properly before running the FSX “Build database” function, in order to make sure all airstrips are displayed. Be careful not
to point Plan-G at the scenery.cfg file to be found in the FS directory itself. This is an FS generated backup copy and is often not up to date.

B) Networked Computers

The simplest way to set Plan-G to find a networked computer is to map a Network drive to the location of FSX.EXE. To “map” (create a short cut to) a network drive, do the following.

Windows XP
1. Open “My Computer”
2. Click the Tools menu, and then click Map Network Drive.
3. If you don’t see the Tools menu, press ALT.
4. In the Drive list, click a drive letter. You can choose any available letter. Starting from Z: and working backwards is recommended for network drives; only to avoid confusion with the “normal” hard disks, DVD drives etc., which start from C:
5. In the Folder box, type the network path of the folder or computer, or click Browse to find the folder or computer.
6. To connect every time you log on to your computer, select the Reconnect at logon tick box.
7. Click Finish.

Windows Vista or Windows 7
1. Open “Computer”
2. Click Map Network Drive on the Command Bar.
3. Continue as for Windows XP.

Your computer is now connected, or mapped, to the network drive. So once you have successfully created a network drive; say Z:\ which points to the network location //MyFSXPC\C:\Program Files\Microsoft Games\FSX, you only need to enter Z:\ in the FSX Program: dialogue box.

In the example path above MyFSXPC is the “Network name” of the FSX PC, created when your network was first set up. (Of course you must use the network name of your FSX PC). You can repeat the process for another network drive Y:\ to point to the location of FS9, if you have it installed. The location of Scenery.cfg, is usually the same Networked drive as for the main FS program location.

You can of course simply enter the full path to these locations, but it is more prone to typing errors than the network drive method, although Plan-G does remember them between sessions and between program updates. Other FS applications can also often make use of network drives.

The default paths in Windows XP and Windows Vista are different, so be careful to map to the correct location. Unlike setting up Locations on a single PC, Plan-G cannot
automatically find FSX on a network, so it is important that you point Plan-G at the correct locations on your FS PC.

Some PCs won’t reveal the target of the networked drive to Plan-G (and other applications – it isn’t a Plan-G problem). The only solution of which TASoftware is aware is to go to (My) Computer, locate the network drive and open that drive in Windows Explorer, i.e. just open the folder to view the contents, no more than that. You can then close the window. Once that is done, Plan-G will be able to find your networked drive by its drive letter. The problem has only been identified in Plan-G when building a new database following a new release. Once this “trick” has been done once, Plan-G always does seem to be able to find the necessary drive and its database when you start it up afterwards.

The Additional Scenery Locations box enables the user to include scenery which has been removed from the scenery.cfg file, but the files themselves are still in place on the system. Some scenery managers switch scenery entries in or out according which region is being used, and therefore the scenery.cfg file may never actually contain the entire scenery library at any one time. By specifying additional locations in this box, which are to be added to the database, the user can have a complete list of all their sceneries in Plan-G. In addition, this list can be used to overcome problems caused by different network mappings when building the database across a network.

Click the ‘Add’ button to open a file browse dialog, and select the required scenery folder – that is the folder which contains the “Scenery” (and usually but not always) the “Texture” sub-folders. Click the Delete button – the one containing the red ‘X’ on the left of the entry to delete that entry.
8.5.2 Units

Because different nationalities use different measuring systems, especially the difference between the USA/Canada and Europe, in order to be as universal as possible, Plan-G can display measurements in Stateside units (feet and inches/Hg); British units (metres/millibars) or European units (Metres/Kilometres/Hectopascals). Europe uses Hectopascals for atmospheric pressure, but these are numerically identical to millibars. Units can be selected for Runway Dimensions, Speed and Distance, Altimeter Setting, Time and Date, for English, American, or European preferences. The rest of the world tends to adopt one of these three systems, although Plan-G allows you to select a non-standard hybrid if you wish.

![Figure 17 The Units Page](image)

The default system used is the English system, with local time and date used in the printable Nav Log. Just click the relevant radio button to change a setting. Settings are remembered by Plan-G, so it will probably be a once-only operation.

8.5.3 Sounds

You can choose to play alert sounds for three situations where your attention is primarily on another task.

1. VNAV Profile Alerts: The alert sounds:
   - One minute before Top of Descent, and
   - When you reach 500ft above your target altitude.
2. Waypoint Alerts: Waypoint alerts sound approximately 30 seconds before reaching a waypoint.
3. Minimums Alert: This sound is played on final approach, 200ft above the airfield elevation. It is not set by default.
You can accept the Windows default (illustrated in Figure 18 above) or choose your own, as long as Plan-G is told where to find it.

8.5.4 FS Connections

There are a number of important configuration options within this tab. They are explained in detail for the various connection options in Section 17 “Connection to Flight Simulator”.

The following two tables are a simple summary of the most commonly used of those options for FS9 and FSX.
### 8.5.5 The GPS Panel

The GPS Panel option allows you to configure the virtual User Aircraft instrument panel that appears whenever Plan-G is connected to an active FS session (See Section 13.3).

#### Max Airspeed

Determines the displayed range (0 to <value>) of the Airspeed Indicator.

---

<table>
<thead>
<tr>
<th>FS9</th>
<th>FS9 &amp; Plan-G on same PC</th>
<th>FS9 &amp; Plan-G on network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect with</td>
<td>Auto/FSUIPC</td>
<td>FSUIPC</td>
</tr>
<tr>
<td>Network Mode</td>
<td>Not used</td>
<td>Not used</td>
</tr>
<tr>
<td>FSX Computer</td>
<td>Not used</td>
<td>Not used</td>
</tr>
<tr>
<td>Server Port/Pipe</td>
<td>Not used</td>
<td>Not used</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FSX</th>
<th>FSX &amp; Plan-G on same PC</th>
<th>FSX &amp; Plan-G on a network with SimConnect</th>
<th>FSX &amp; Plan-G on a network with FSUIPC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect with</td>
<td>Auto</td>
<td>Auto or SimConnect</td>
<td>FSUIPC</td>
</tr>
<tr>
<td>Network Mode</td>
<td>Not used</td>
<td>IPv4 (Win. XP) IPv6 (Vista/W7)</td>
<td>Not used</td>
</tr>
<tr>
<td>FSX Computer</td>
<td>localhost</td>
<td>IP Address (192.168.0.2 etc) Value must be same as SimConnect.xml</td>
<td>Not used</td>
</tr>
<tr>
<td>Server Port/Pipe</td>
<td>Not used</td>
<td>Range 4500 to 4510 Value must be same as SimConnect.xml</td>
<td>Not used</td>
</tr>
</tbody>
</table>

**Note:** If installing FS9 & Plan-G on a network, you need Peter Dowson’s WideFS, as well as FSUIPC. There are more details about WideFS in section 20.2.1.
**CDI Sensitivity**
This is the course deviation that can be tolerated before Plan-G will update the CDI bar. Choices are (deviation from flight plan track): -

- Auto
- 5 nm
- 1.25 nm
- 0.5 nm

**VNAV Targets\ VNAV Profile**
VNAV stands for Vertical Navigation, more familiar to those who fly high and need to plan how to get down, than the VFR flyer cruising at 2000 feet. IFR pilots must descend at a rate not less than 500 feet per minute, so the profile value is important too. These parameters determine where and when Plan-G will issue its popup warning windows to alert the pilot to his progress along the planned route.

**Waypoint/ETE Display**
These two selections determine the additional information Plan-G displays at the top and bottom of the GPS panel. Choices are:

- Distance to Waypoint
- ETE (Estimated Time En Route) to Destination (how long will it take from here to get to the final destination)
- Time to Waypoint
- Heading to Waypoint

**8.5.6 User Aircraft**
This page sets up options about your own aircraft. Firstly you can choose whether to display your own aircraft or not.

You have the ability to show your flight “trail” or “track made good” (what it is called depends on who you talk to). You can change the colour and line width if the defaults are not to your liking. You can also record and save your trail for future analysis.

Practice those overhead joins or procedural turns and then see what flight profile you actually achieved against the neat version on the approach chart!

Note that flight trail display and recording is selected “Off” by default when Plan-G is first installed.

The three radio buttons; Free, Sync and Lock describe how the yellow user aircraft behaves in relation to the map. These functions are also available and the option can be changed from the Home ribbon. The tooltips describe exactly the behaviour in each case.
8.5.7 Traffic

**Free**: The Map and user aircraft are not synchronized. You can move the map wherever you like, and it won't be synchronised with the plane. If you don't move the map, the plane will fly off the edge (and will never be seen again.)

**Sync**: The Map will move as necessary to ensure the yellow aircraft remains visible on screen. You can move the map, but it will re-centre on the yellow aircraft when it is refreshed a few seconds later (10 seconds is the default, but it can be changed in the FS Display window.) If you leave the map alone, it will stay where it is until the plane reaches the edge, when it will re-centre.

**Lock**: The user aircraft stays in the centre of the Map. The map is re-centred on the user aircraft at every refresh. The aeroplane effectively stays in the middle of the map. This can degrade Plan-G’s performance on some less powerful computers.

If the “Update TAS from FS” tick box is ticked, and if a flight plan is loaded, and if Plan-G is connected to FS, then Plan-G shows the true airspeed (TAS) in the Airspeed dropdown (accessed from the Home Ribbon), taken directly from FS. The user will have entered an estimated indicated airspeed in the Airspeed dropdown while compiling a flight plan, but if the “Update TAS from FS” tick box is ticked, that value is replaced by the TAS from FS. Effectively the flight plan is updated dynamically during a flight.

If the “Show waypoint alerts” tick box is ticked an alert is displayed before reaching the next waypoint on your flight plan.

### Figure 21 User Aircraft Options

**Free**: The Map and user aircraft are not synchronized. You can move the map wherever you like, and it won't be synchronised with the plane. If you don't move the map, the plane will fly off the edge (and will never be seen again.)

**Sync**: The Map will move as necessary to ensure the yellow aircraft remains visible on screen. You can move the map, but it will re-centre on the yellow aircraft when it is refreshed a few seconds later (10 seconds is the default, but it can be changed in the FS Display window.) If you leave the map alone, it will stay where it is until the plane reaches the edge, when it will re-centre.

**Lock**: The user aircraft stays in the centre of the Map. The map is re-centred on the user aircraft at every refresh. The aeroplane effectively stays in the middle of the map. This can degrade Plan-G’s performance on some less powerful computers.

If the “Update TAS from FS” tick box is ticked, and if a flight plan is loaded, and if Plan-G is connected to FS, then Plan-G shows the true airspeed (TAS) in the Airspeed dropdown (accessed from the Home Ribbon), taken directly from FS. The user will have entered an estimated indicated airspeed in the Airspeed dropdown while compiling a flight plan, but if the “Update TAS from FS” tick box is ticked, that value is replaced by the TAS from FS. Effectively the flight plan is updated dynamically during a flight.

If the “Show waypoint alerts” tick box is ticked an alert is displayed before reaching the next waypoint on your flight plan.

### Figure 21 User Aircraft Options

**Free**: The Map and user aircraft are not synchronized. You can move the map wherever you like, and it won't be synchronised with the plane. If you don't move the map, the plane will fly off the edge (and will never be seen again.)

**Sync**: The Map will move as necessary to ensure the yellow aircraft remains visible on screen. You can move the map, but it will re-centre on the yellow aircraft when it is refreshed a few seconds later (10 seconds is the default, but it can be changed in the FS Display window.) If you leave the map alone, it will stay where it is until the plane reaches the edge, when it will re-centre.

**Lock**: The user aircraft stays in the centre of the Map. The map is re-centred on the user aircraft at every refresh. The aeroplane effectively stays in the middle of the map. This can degrade Plan-G’s performance on some less powerful computers.

If the “Update TAS from FS” tick box is ticked, and if a flight plan is loaded, and if Plan-G is connected to FS, then Plan-G shows the true airspeed (TAS) in the Airspeed dropdown (accessed from the Home Ribbon), taken directly from FS. The user will have entered an estimated indicated airspeed in the Airspeed dropdown while compiling a flight plan, but if the “Update TAS from FS” tick box is ticked, that value is replaced by the TAS from FS. Effectively the flight plan is updated dynamically during a flight.

If the “Show waypoint alerts” tick box is ticked an alert is displayed before reaching the next waypoint on your flight plan.

### 8.5.7 Traffic

This page sets up options about other aircraft when connected to FS. These may be aircraft artificially generated by FS, (known generally simply as “AI”) or other aircraft being flown on a multiplayer network such as VATSIM or IVAO, when you are logged in to one of their servers.

Firstly you can choose whether to display AI/multiplayer aircraft or not. You can decide the range beyond which they will not be displayed, and if the apron is full of aircraft, you can turn off “Show Parked” aircraft, by unticking the relevant tick box.

In the same way as for your own aircraft, you can show the flight trail for each of these. You can change the colour and line width if the defaults are not to your liking. You can
also record and save the trails for future analysis. See the chaos you caused ploughing through Heathrow’s Class A airspace, VFR in your microlight, forcing all those IFR go arounds and aborted takeoffs!!!!

Figure 22 Traffic Options

Note: AI flight trail display and recording is selected “Off” by default when Plan-G is first installed, the same as your own flight trail.

8.5.8 Weather

The “Display Nearest Weather” tick box makes Plan-G get the weather from FSX. This may be user generated within FS, or may be from an online system, e.g. if FSX is set for Jeppesen, then that is the weather station data displayed. If connected to an online service such as IVAO, the weather fed to FS from IVAO via the IVap pilot client software, is in turn passed to Plan-G.

“Update Local” updates Plan-G with the wind setting from FS at the user’s location, when connected to an online weather service.

Figure 23 Weather Parameters
9 THE HOME RIBBON IN DETAIL

The "Home" ribbon menu contains the options you need to set up the parameters of your new flight plan. Changes made here will be displayed in the "Plan" expander on the right of the Plan-G window, and they will be saved to your new Flight Plan when you click the "Save" or "Save As" buttons.

Those ribbon buttons with a small down arrow beneath the label are "split buttons". Clicking the icon itself will activate the default action (e.g. Find Airport), while clicking the bottom half which has the label and the arrow will display a menu of choices (Find VOR etc...).

9.1 Find

The "Find" button allows you to search for an airport or radio navigation aid. The Find button is a "Split" button. Clicking the icon, (top half of button) activates the default action, in this case Find Airport. Clicking on the lower half of the button drops down a list of objects you can search for:

- Find Airport (Search by International Civil Aviation Organization (ICAO) code, by airport name, or by city name)
- Find NDB (Search by 3-letter identifier or by name or partial name)
- Find VOR (Search by 3-letter identifier or by name or partial name)
- Find User VRP (User Visual Reference Points or User Waypoints) are other points of interest that can be created by the user and added to a Plan-G database.)

![Figure 24 Using the Find Function to Locate an Airport](image)

If the searched for item exists in your simulator’s database, it will be found, and the map will centre on it. If the item does not exist, Plan-G does nothing. You can select “Cancel” to return to the map view, or enter some search text that Plan-G can find. Search text is NOT case sensitive.
**Note:** the Find airports dialog now includes a “CSV” button. This button allows the user to save a list of the airports in the table above it. This may be the whole FS database of airports (may be a very large file) or just a small number, depending on the Country, State and City filters applied. Clicking this button opens a “Save As” dialog for the user to select a filename for the csv formatted data and a location to store it.

### 9.2 Print

There are three print options: to print the map; the flight plan or the terrain profile. You can preview each printout and set page parameters before printing, e.g. whole page; page width etc. via a series of small icons at the top of the print preview window. Each icon has a tooltip, so you can quickly select which one you need. You can of course print them all, but they print separately.

The Print button is a “Split” button. Clicking the icon, (top half of button) activates the default action, in this case Print Preview. Clicking on the lower half of the button opens a small menu. Select Quick Print from the menu to print directly, without a preview window.

If no flight plan has been loaded or newly created, the “Flightplan” print button is greyed out. If no DEM data is installed, the “Terrain” print button is greyed out.

### 9.3 Start Position

Plan-G extracts the runways and parking spaces available at your planned departure airport from the FSX or FS9 database. Initially, the icon is a faded blue, but once you have created your flight plan, it is displayed in a crisper dark blue. This indicates that it is available for use.

![Set Airport Start Position](image)

**Figure 25 Start Position Window**

Click on the icon to display a window containing the options. Some airports have more options available than others, usually depending on how big the airport is in terms of runways, taxiways, importance even. When the Flight Plan is saved, then loaded into FSX or FS9, this will be the place (and zeroed elapsed time) from which your simulated flight will depart.
9.4 **Altitude**

Here you can set the overall planned altitude for your new flight plan, after consulting the Plan-G map for airspace and terrain constraints.

"Passing Altitudes" can be set for individual waypoints, by editing the plan table directly. These altitudes are not able to be used directly by FS.

![Figure 26 Cruising Altitude Window](image)

![Figure 27 Cruising Airspeed Window](image)

9.5 **Airspeed**

Your planned airspeed is entered here so that Plan-G can calculate the duration of each leg and the complete flight. Plan-G uses true airspeed not indicated airspeed. If you then change for a faster aircraft in FSX/FS9, you will have to manually change your estimated true airspeed here. With a flight plan open, changing true airspeed recalculates the leg times and the flight total elapsed time.

9.6 **Winds**

A wind value entered in this window will be used to calculate the heading required to maintain your planned track. If a wind value is entered, Plan-G will also calculate and display your ground speed.

If you are connected to FS9/FSX, and provided you have “Update local” ticked in File/Options/Weather, then the FS9/FSX wind will be automatically passed to Plan-G for flight plan calculation and will be displayed in the Winds dialogue box when you open it.

9.7 **VFR/IFR**

A flight is conducted either under Visual Flight Rules or Instrument Flight Rules. These buttons select the flight rules and the plan will estimate a suitable altitude, taking flight rules into account.

9.8 **Quick**

Clicking the “bow and arrow” icon (officially called the “direct to” icon by GPS manufacturers) reveals a very neat feature for a quick and dirty “A to B” plan. Enter the ICAO codes for departure and destination, and Plan-G quickly generates a Great Circle direct track between the two. This is very handy for short flights or answering questions such as “Have I got time to fly from A to B this evening?”
9.9 Reverse
This button reverses the sequence of waypoints in a loaded flight plan. This is useful for creating a new flight plan for the return trip. The window title in Plan-G will reflect a new name for the reversed flight plan, and when you save it, Plan-G automatically changes the name for the new, reversed plan.

9.10 The Edit Button
When the ‘Edit’ button is pressed, click-drag-release editing is possible on the track line of your flight plan. The Edit Button functionality is fully described in section 16 below.

9.11 The Frame Button
If a flight Plan is loaded and displayed on the map, clicking this button will move the map view to centre the displayed flight plan into the middle of the map area, and will adjust the zoom level to include the whole of the plan in one view. If no flight plan is loaded, clicking the Frame button has no effect.

9.12 Copy Route
This option copies the flight plan route to the windows clipboard from where it can be pasted into VATSIM or IVAO Flight Plans, or used for generating Pilot Reports (PIREPS) for your Virtual Airline. If you want to exclude the departure and destination points (for flight plans), press SHIFT as you click the button. The button is greyed out if no Flight Plan is loaded.

9.13 Range Rings
Range Rings can be useful for estimating distance or time to run, if you are connected to FS9/FSX. There are two modes: distance mode and time mode. The rings display in yellow, centred on the current cursor position. The default distance range is 20 miles, the default time range is 30 minutes. For VFR flying, you may prefer these values to be 10 miles and 10 minutes respectively. You can display 1, 2 or 3 rings, selectable from the ribbon menu. Range rings do not require you to be connected to FS. They are purely a mapping display function. You can only display one set of rings.

Switching Range Rings on or off is achieved from the right-click dropdown menu. See section 14.1.2 for further details.

9.14 Bookmark
This is a most useful feature if you are in the habit of flying to and from places scattered round the globe. Click the Bookmark button to open a files window. If you enter a file name (of your choice) the current map view is saved with that name as a bookmark.

When you are elsewhere in the world, and want to quickly return to the bookmarked map view, just click the small dropdown arrow below the Bookmark button on the ribbon, and select “Open” from the two available choices. The bookmark files window again opens, but this time, click on the bookmarked file name of the location you wish to go to, and click the “Open” button at the bottom right of the files window. The window immediately closes and the map view changes quickly to the selected location.
9.15 KML

KML is a file format used to display geographic data in an Earth browser such as Google Earth, Google Maps, and Google Maps for Mobile. KML code is based on the XML standard and adds features that can be created with the Google Earth user interface. These features include placemarks, descriptions, ground overlays, paths, and polygons. When a text file is saved with a .kml or .kmz extension, Earth browsers know how to display it.

In Plan-G, .kml or .kmz files can be opened and the features coded therein will be displayed as an overlay on the Plan-G map. However, any .kml or .kmz file used must be located on a web site due to a Google Maps limitation.

When the user clicks the KML button, a file window opens in which the URL of the KML file must be entered, (or you can select one from those displayed – several examples have been included). Long URLs are truncated in the list, but the full URL is displayed as a tooltip.

If the user enters a KML file URL, or selects one of the examples provided, on clicking OK in the file window, Plan-G will display the KML overlay. The KML window also opens if you click the small dropdown arrow below the KML button on the ribbon, and select “Show” from the two available choices. If you select “Clear”, the overlay is removed from the map. There are three tickboxes at the bottom of the KML window. The first two are self explanatory. The third tickbox hides or displays the example links provided with Plan-G.

Note: Opening a KML overlay does not remove any existing overlays. You can have more than one displayed at a time. The Clear command however, will clear all KML overlays from the display. Be aware that loading and display of KML files may be quite slow on some systems, which could make it seem as if Plan-G has stopped working.
9.16 **Connect/Disconnect**

This very important option requires initial configuration and is described fully in section 17 below.

9.17 **Map Panning Control**

If the user is connected to Flight Simulator, the Plan-G map display update can be controlled in one of three ways:

- **Lock:** The User Aircraft remains in the centre of the map area, and the map moves as the aircraft progress through the flight. This is very processor intensive and may slow the computer down. The map refreshes approximately every 7 seconds.
- **Sync:** When the User Aircraft reaches the edge of the map area, the map refreshes with the aircraft now in the centre of the map area.
- **Free:** The aircraft moves independently of the map display, and may “fly off” the edge of the displayed map. Dragging the map will bring the aircraft back into view.
10 THE MAP RIBBON IN DETAIL

10.1 User Configured Settings

At every zoom level, the default structure is designed to maintain the speed of map refreshing by turning off more and more detail as you zoom out. However, the settings for each tick box item can be user configured for each zoom level to be displayed or hidden according to preference.

User configured settings for each zoom level are remembered for the next time you open Plan-G. For example, if you switch on, say small airports at zoom level 9, (they are switched off by default at this level) they are only switched on for that zoom level and any others in which they are switched on by default (zoom level 10 and higher numbers). So every time you return to zoom level 9 the small airports will be displayed even though they are normally switched off at this level.

![Figure 29 The Map Ribbon](image)

10.2 Reset Display Defaults

If you try and display a large amount of data at low zoom levels, (for example selecting zoom level 3, then ticking the boxes on the Map Ribbon to display all airfields, all navaids, intersections, and user waypoints plus all the controlled airspace), Plan-G tries for so long to display all this data, then gives up and a warning message is displayed.

![Figure 30 Script Message Generated When Trying To Display Too Much Data](image)

You should click the “Yes” option and go to the Map tab and deselect some object types or reset your view settings to the default by clicking the “Reset All” button.

However if Plan-G has become unresponsive due to trying to display too many objects at your present zoom level, you should exit Plan-G, open the Plan-G folder (usually in C:\Program Files), and find a program file called Mapreset.exe. If you run this program (e.g. by double-clicking the file name), the features displayed at each zoom level are reset to the default. You can then restart Plan-G.
If you have this problem frequently, possibly because of the specification or processing speed of your PC, there is a more permanent solution described in Appendix 3 at section 22.3 of this manual.

10.3 Airports
The Airports in Plan G are extracted from Flight Simulator and stored in the relevant database. Airports close in the real world, and new ones are built. Flight Simulator is however frozen in time (FSX is frozen at 2005, FS9 at 2004) so there will be differences from the real world in Plan-G as there are in FS.

At each zoom level, airports are selectively displayed; the largest only being displayed at low zoom levels (map displays a large land area). To see small airports you must zoom in to a higher zoom level. By default:

- No Airports are displayed at zoom levels 1-7
- Large Airports are first displayed at zoom level 8
- Medium Airports are first displayed at zoom level 9
- Small Airports are first displayed at zoom level 11

The airport size reference used in Plan-G refers to the length of the longest runway.

- Large: Longest runway is 3,000m or more in length;
- Medium: Between 800m and 2,999m in length
- Small: Less than 800m in length

In this section of the Map ribbon there is also a slender green arrow symbol labelled ILS/LOC. This symbol, called “ILS feathers” is used on aeronautical charts to denote an Instrument Landing System (ILS). If this button is pressed, those airports that are selected for display (Large, Medium and/or Small) where those airports have runways equipped with ILS/LOC in FS, will have “feathers” displayed against them on the appropriate approach bearing.

Note that if a real world airport runway has an ILS which is not featured in FS9/FSX, then the feathers are not displayed. (remember: FSX is frozen at 2005, FS9 at 2004), so because real world approach aids are changing year on year, such differences may become more common over time.

By default, the feathers display at zoom level 8 or higher. The setting is remembered for the next time you open Plan-G.

10.4 Navaids
The radio navigation aids (Navaids) in Plan G are also extracted from Flight Simulator and stored in the database and subject, naturally, to the same obsolescence as Airports.

Very High Frequency Omni-Range beacons (VORs) and Non-Directional Beacons (NDBs) are probably familiar to most Sim-pilots. There is an excellent tutorial on the theory and practice of using these on the Cix VFR Club website at:

http://www.cixvfrclub.org.uk/training/tutorials/pdf tutorials/The%20IMC%20Rating.pdf
The tick boxes allow you to display or hide VORs and NDBs at different zoom levels, if the default settings are not suitable for a particular route and plan you are developing.

ISEC is the standard aviation abbreviation for Intersections. Intersections exist in two forms, named (normal) and unnamed. Named intersections are the standard type of intersection. On the Navaids section of the Map Ribbon, the “ISEC” tick box switches on or off named intersections, and the “ISEC (unnamed)” tick box switches on or off unnamed intersections.

Named intersections are now commonly used in VFR flight, resulting from the increasing use of GPS worldwide. Some are included in GPS Databases and VFR pilots can navigate to them simply. Because it isn’t easy to discriminate between those useful to VFR pilots and those which are not, Plan-G includes all the ones identified in FS. (e.g. ORTAC at N50.00° W002.00° well known to VFR pilots crossing the English Channel).

Unnamed intersections are computer generated 'infill' intersections. They still have names, but these names are generally not memorable. Unnamed intersections are generally not valid for use as a turning point on an IFR flight plan.

![Figure 31 The ORTAC Intersection In the English Channel](image)

The intersection symbol is a small triangle. Blue triangles denote 'terminal' intersections, i.e. they are "owned" by an airport, and typically form part of an approach procedure. Magenta intersections are 'En Route' intersections, and typically are associated with an airway.

In addition to the above, user intersections can be defined, and these are denoted by green triangles.

By default, intersections are not displayed at any zoom level.

Plan-G can display Lower Airway routes if the Lower Airways tick box is ticked. Airways are radio and area navigation routes within which ATC ensures smooth and orderly traffic. Lower Airways are routes up to a 24,500 feet ceiling above sea level, primarily used for smaller aircraft or short flights. Upper airways are reserved for larger jets on long flights, and are not provided in Plan-G.
10.5 Airspace

All airspace is classified according to a system defined by the International Civil Aviation Organisation (ICAO). The table below provides an overview of the classes, and the specifications for each.

Plan-G displays Classes A to E if the “ICAO Airspace” tick box is ticked. Classes F & G are commonly referred to as the “Open F.I.R. (Flight Information Region) and is principally the domain of light aircraft, microlights, balloons etc. Most commercial flights and all “heavy” category aircraft almost exclusively conduct their flights in Controlled Airspace (CAS) under ATC control. When planning your flights it is essential to know, therefore, where you can and cannot go, and Plan-G provides the information.

In addition, Plan-G splits the airspace displayed into two – below 10,000ft and above 10,000ft, again by ticking the appropriate tick box. In the real world, unpressurised aircraft are not permitted to maintain sustained flight above 10,000 feet, (12,500ft in some countries), because the crew cannot take in sufficient oxygen to maintain their mental faculties, and are prone to make irrational decisions. Not good in an aeroplane!

<table>
<thead>
<tr>
<th>Class</th>
<th>Controlled</th>
<th>IFR</th>
<th>SVFR</th>
<th>VFR</th>
<th>ATC Clearance</th>
<th>Separation</th>
<th>Traffic Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Controlled</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Required</td>
<td>Provided</td>
<td>N/A</td>
</tr>
<tr>
<td>B</td>
<td>Controlled</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Required</td>
<td>Provided</td>
<td>N/A</td>
</tr>
<tr>
<td>C</td>
<td>Controlled</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Required</td>
<td>Provided</td>
<td>Provided for all VFR</td>
</tr>
<tr>
<td>D</td>
<td>Controlled</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Required</td>
<td>Provided</td>
<td>Provided for all IFR and VFR</td>
</tr>
<tr>
<td>E</td>
<td>Controlled</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Required for IFR</td>
<td>Provided</td>
<td>Provided for all IFR and VFR where possible</td>
</tr>
<tr>
<td>F</td>
<td>Uncontrolled</td>
<td>No</td>
<td>Yes</td>
<td></td>
<td>Not required</td>
<td>Provided</td>
<td>Provided where possible</td>
</tr>
<tr>
<td>G</td>
<td>Uncontrolled</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Not required</td>
<td>Not provided</td>
<td>Provided where possible</td>
</tr>
</tbody>
</table>

**Figure 32 ICAO Airspace Classification**

So if you are a light aircraft enthusiast, you can switch off controlled airspace (CAS) boundaries above 10,000ft, and reduce Plan-G’s processing workload. And if you are crossing the USA in a 747 at 35,000ft, you can save Plan-G some work by switching off the “Below 10,000ft” CAS tick box.

The “Centre” tick box displays or hides the Air Route Traffic Control Center (ARTCC) boundaries. Generally referred to as “Centre” they are responsible for controlling instrument flight rules aircraft en route in a Flight Information Region at high altitudes between airport approaches and departures. In the UK the National Air Traffic Service (NATS) combines the London Terminal Control Centre (LTCC) and London Area Control Centre (LACC) at the Swanwick facility. Centre is unticked by default at all zoom levels.
In addition to the classified airspace, there are two “Special Use” tick boxes. “Special Use 1” displays Danger Areas, Restricted Areas and Prohibited Areas. Special Use 2 displays “the rest” – military low flying areas, air to air refueling areas, high altitude danger areas etc. For VFR pilots, these are normally an issue, and for IFR pilots, IFR routes invariably avoid these areas. Special Use 1 & 2 are switched off by default at all zoom levels.

The Launcher button at the bottom right of the Airspace ribbon area opens a window showing every classification of airspace and the boundary colours used in Plan-G.

10.6 User Waypoints
User waypoints may be created in 12 different types

![Figure 33 The 12 Predefined Types of User Waypoint](image)

User Waypoints are stored in a User Waypoint database. Many of these are provided in the Plan-G package in the file UserWaypoints.sdf. These can be optionally displayed or hidden by ticking the relevant tick box on the Ribbon.

If you add your own waypoints (see sections 10.6 and 16.5) they can be categorised in one of the 12 options shown above. This also means that only selected ones are displayed, in the same way as other features.

Note: Whenever a new version of Plan-G is issued, the file UserWaypoints.sdf is overwritten, so if you create your own waypoints, be sure to keep a safe copy somewhere outside the Plan-G folder. Further details are included in section 16.5.

10.7 Reset Defaults
If you click the “Reset Defaults” icon all your user configured display settings are deleted and the default options are reapplied.

10.8 Fix Overlays
If you click this button, then all the data overlays, e.g. size of airports, controlled airspace, and user waypoints are fixed if you zoom further in. In other words, the default values for higher zoom levels are overridden. However, if you zoom out, the previously defined (or default) overlay settings are used to prevent map re-draw overload leading to the “Script running slowly” message (See section 10.2 above) sometimes seen.
11 THE DATA RIBBON IN DETAIL

This is the ribbon which allows you to create the database for the simulator version you have. If you have both FS9 and FSX, you can create a database for both. There is also the option to manage your User Waypoint Database; creating, adding, modifying or removing your own defined Waypoints. See section 10.6 above for full details.

These FS database options are of course only available for the simulator version or versions you have installed. If you do have both FS9 and FSX installed, either on the same computer or on separate networked computers, then you can create a database for both simulator versions, and create flight plans for either.

If FSX exists on the same computer as Plan-G, or a networked computer with FSX installed, then the “Build FSX Database” icon will be a strong blue colour, otherwise it will be a faded blue colour.

If FS9 exists on the same computer as Plan-G, or a networked computer with FS9 installed, then the “Build FS9 Database” icon will be a strong grey colour, otherwise it will be a faded grey colour.

If both versions of Flight Simulator are detected by Plan-G, then both “Build Database” icons will be a strong colour: blue for FSX; grey for FS9. In addition to the two drum shaped icons is a small “launcher button” (a small diagonal arrow), at the bottom right of that section of the Data Ribbon. If you click that arrow, it opens a “FS File Locations” window, which displays the current paths to FSX Program, FSX Scenery.cfg or FS9. These are exactly the same options and serve the same purpose as the similar options accessed from the “File” menu, (see section 8.5.1 above) and give the user the opportunity to change the paths if one or more is incorrect.

You can select which database is used for the map display (airports, navaids controlled airspace etc.) by clicking one of the “Active FS Version” icons. If the database for that version of FS exists, the icon is shown with an orange background and the map will display data from that database.

If no airports, controlled airspace or navaids, or any other aeronautical data appear on the map when the correct “Active FS Version” for your sim is displayed, then you should rebuild the database.

Note that for networked PCs, the icons will only display in the “Active” (strong colour) mode if the correct communication protocols are in place (see section 18.2 below).
12 THE VIEW RIBBON IN DETAIL

Plan-G can be very slow, stall altogether or throw up “Script Errors” if you try and display too much data at any one zoom level. As a general rule, the default settings are optimum for most users, but invariably each will have their own preferences. The View Ribbon allows the user to filter unwanted general display features, with the ability to turn them on or off as they wish.

If you do accidentally try and display too much data, and Plan-G grinds to a halt, section 10.2 tells you how to recover the situation. A more technical solution involving changing a Registry value is given in Appendix 3, section 22.3)

12.1 Plan Elevation Tick box

This feature requires the optional download and installation of one or more Digital Elevation Model (DEM) tiles from the NGDC ‘GLOBE’ (Global Land One-km Base Elevation) website at [http://www.ngdc.noaa.gov/mgg/topo/gltiles.html](http://www.ngdc.noaa.gov/mgg/topo/gltiles.html).

You need to download and install a minimum of one tile to enable the functionality. You do not need to download and install every tile (no elevation data will be shown in Plan-G where tiles are not installed). The tile files are TAR compressed files with the extension “.gz”. They can be extracted with Winzip. The extracted files have no extension. The extracted files must be placed in the Plan-G\DEM folder. For example, Plan-G\DEM\f10g is the file for the tile that covers the U.S. Eastern seaboard.

When a Flight Plan has been loaded, and the Plan Elevation tick box selected on the Home Ribbon, an elevation window will open at the bottom of the Plan-G screen.

![Flight Plan Elevation Window](image)

*Figure 37 Flight Plan Elevation Window below the Map Window*

The Flight Plan Elevation window shows for each leg, the Suggested Altitude as a solid mauve line, the Maximum Elevation Figure (MEF) as a dotted red line, the distance, elapsed time and altitude at the mouse cursor, and the DEM profile in green.
move the mouse around the elevation window, you will see that the pointer becomes a crosswire symbol, except when in contact with the surface when it becomes a yellow circle with a smaller dot symbol inside which stays in contact with the surface as you move the mouse. The numbers alongside the dot indicate distance from the origin and elevation.

If no tile files exist in the folder Plan-GDEM the Plan Elevation tick box is displayed in a faint grey and cannot be selected. If no flight plan is loaded the elevation window is displayed, but contains no elevation data.

12.2 Map Graticule
This button toggles on or off the latitude and longitude graticule. At zoom level 8, the lines are drawn at 1° intervals. At higher zoom levels, the lines are drawn at smaller intervals and at lower zoom levels, larger intervals. The actual values are shown against the leftmost longitude line, and the lowest but one latitude line. The graticule setting is remembered for the next time you open Plan-G.

12.3 Map Overlays
If you want to just look at the map without any aeronautical information displayed at all, click this tick box. Click again to remove the tick and all the overlay data is redisplayed.

12.4 Expander Icon
The Expander Icon to the immediate right of the three tickboxes enables or disables the display of the Expander Panel on the right of the Plan-G screen. The Expander Panel is displayed by default. Hiding the expander panel will of course allow a larger map area to be viewed (the zoom level does not change). If you choose to hide the Expander Panel, you can still view the Expander panel options in a Tool Window.
Whether or not the Expander Panel is hidden, if you click the small down arrow below the Expander icon, a dropdown menu is displayed. From this menu you can select each of the Expander Panel options and select whether to show it, hide it or display it in its own “Tool Window”.

Tool Windows stay on top of other windows and do not change position unless you drag them to a new position with the mouse.

The Tool Window feature is especially useful for viewing flight plans, as it can be awkward trying to view a flight Plan in the Expander Panel, having to scroll left and right to check different elements.

![Figure 39 A Flight Plan viewed in a Tool Window](image)

### 12.5 Alternative Zoom Controls

If the Google Maps standard zoom controls are not to your liking, there are a pair of zoom buttons as an alternative.

In addition there are three configurable preset zoom buttons. By default they are set to 8 times, 10 times and 12 times zoom level. Clicking the small launcher button (the diagonal arrow symbol) at the bottom right of the preset zoom buttons group opens a “Set Zoom Presets” window, where you can change the default settings to your choice.

### 12.6 Keep Window on Top

Click the pushpin icon and Plan-G stays on top of all other windows. This can be handy if you are running with two monitors, (you wouldn’t want to use this feature while flying, with a single monitor), if you have other windows getting in the way on occasion. It can be a bit unnerving if you have Plan-G in full screen mode, as it can at first seem that your computer is not responding to mouse clicks on other running applications in the task bar.
13 THE DATA EXPANDERS

On the right of the map is a small table of labels with an arrow in a circle next to each. These are the Data Expanders. If you click on the "arrow in a circle" symbol, the selection clicked expands to show the data beneath it. Clicking the arrow in a circle again collapses the relevant section once more. The arrow symbols indicate whether the section is currently collapsed or expanded. Dragging the left hand boundary of the Expander area will enlarge or shrink the Expander Area and that position will be remembered between sessions.

The Data Expander panel can be switched off by clicking the Expander Panel tick box on the Home Ribbon. Similarly, if it is not visible when you start Plan-G, it can be enabled by clicking the Expander Panel tick box (See section 9.14 for further detail).

13.1 Plan

Expanding this option allows you to see your flight plan as a table with the conventional flight plan headings. When your plan is expanded in this way, you can add or delete waypoints, or move the waypoints up or down the plan by right clicking the relevant entry in the plan to reveal the dropdown menu of options.

MEF (right hand column) stands for the Maximum Elevation Figure, and is the highest point (not including masts, skyscrapers etc.,) in a 0.5° square through which the track
passes. The MEF for a leg analyses all the grid squares through which the leg passes, and uses the highest value. The source data is the National Oceanic and Atmospheric Administration (NOAA) 1.2km GLOBE dataset – the same source as the DEM tiles.

13.2 Weather

With Plan-G connected to FSX/FS9, and showing the user aircraft position, the Weather drop-down data expander reads the weather data from FS9/FSX and shows everything that FSX/FS9 “knows” about the weather conditions for the current flight. This FSX/FS9 weather data may be the built in weather themes, user modified weather, weather from an online server such as VATSIM or IVAO (if connected to such a server, or real-world Jeppesen weather (FSX only). Plan-G displays all the available weather data, as shown in the following extract.

![Figure 44 Weather Table](image)

If you select "Download Weather from NWS" (access via the File tab, in Options/Weather), weather from the NOAA will be displayed without having to be connected to FS. The format displayed in the table is very slightly different however, since it comes from real METARs, rather than the adapted data provided by FS.

13.3 GPS Panel

If Plan-G is connected to FS then this line, when expanded, shows the user aircraft’s performance instruments. This can be useful, for instance, where you have only one monitor, but you need to check out progress on Plan-G and also make sure your hand flown VFR aircraft doesn’t suddenly enter a spiral dive while your attention is elsewhere.

![Figure 45 GPS Panel](image)
The instruments are not labelled, but it is obvious which they are – the basic “6-pack” except for the horizontal situation indicator (HIS). Airspeed and altitude are also shown digitally.

13.4 A Special HSI

An additional feature of Plan-G is a Horizontal Situation Indicator with more than attitude! It incorporates a wind arrow plus four navigational features.

a) A Direction Indicator (DI)
b) A Course Deviation Indicator (CDI), and
c) An Automatic Direction Finder (ADF)
d) A Descent Profile Indicator

These features are only available, however, if a flight plan is loaded and Plan-G is connected to FS. Figure 45 above shows the GPS Panel as it appears when no flight plan is loaded. Figure 46 shows the GPS panel during a flight with a Flight Plan loaded.

![Figure 46 The GPS Panel “Alive” during a Flight with a Flight Plan Loaded](image)

13.4.1 The Wind Arrow

The wind arrow is the standard meteorological symbol used for winds on weather charts, with an arrow head showing the wind direction, and up to three “barbs” on one side. In Plan-G it is blue, and shown aligned along a compass bearing on the graduated circle of the HSI. It indicates the TRUE bearing of the wind, so you need to make the normal adjustment for magnetic variation. (Variation west, magnetic best: variation east, magnetic least). Wind strength is indicated by the number and size of the barbs. Each large barb represents 10kts, and a small barb represents 5kts. So a wind speed of 25kts is shown as two large and one small barb. Wind speeds less than 5kts have no barbs.

13.4.2 Direction Indicator

Most virtual pilots should be familiar with a DI. This one is identical to that found in your aircraft, except that it doesn’t precess with time. If precession is not a term you are familiar with, look up “Direction Indicator Precession” on the internet and read all about it. It shows the magnetic heading you are flying against the red lubber line at the top.
13.4.3 Course Deviation Indicator

The yellow needle and the central bar form a CDI with a slight difference. It isn’t tuned to a VOR, but is indicating your deviation from the flight plan track line displayed on the map. The sensitivity varies with distance from destination. Full Scale Deflection (FSD) for various distances is shown in the table below.

<table>
<thead>
<tr>
<th>Distance from Waypoint</th>
<th>Sensitivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>More than 35nm</td>
<td>FSD = 5nm from track</td>
</tr>
<tr>
<td>Between 2nm and 35nm</td>
<td>FSD = 1.2nm from track</td>
</tr>
<tr>
<td>Less than 2nm</td>
<td>FSD = 0.25nm from track</td>
</tr>
</tbody>
</table>

This is the same as the sensitivity of an ILS localiser.

13.4.4 Automatic Direction Finder

This is an ADF with a difference. The small green arrow works exactly like an ADF tuned to an NDB, but it points directly to your next waypoint. It is not influenced by thunderstorms or mountains of iron ore, so is more reliable than a real world ADF (not that magnetic mountains are simulated in FS!)

It does get more sensitive as you get nearer to the waypoint, and swings round in the normal way an ADF needle does as you pass the waypoint. When Plan-G decides it is time to look for the next waypoint, it will swing round automatically to point to the new one. If you are directly on track, this will be the instant that the aircraft passes over the waypoint. If you are off track a little, it tends to move round to about 150° before changing, so don’t chase the needle as you near the waypoint.

13.4.5 Descent Profile Indicator

The fourth feature is the descent profile indicator. Whether you create an altitude profile or not, Plan-G will calculate a Top of Descent point along your route. As you near the Top of Descent, the profile bar (a small green letterbox shaped rectangle) appears on the HIS dial, and descends downwards.

This is similar to a glideslope indicator and shows the rate of descent you need to achieve to maintain your VNAV profile. It works in the same sense as an ILS glideslope indicator. If the bar is below the centre, you should increase your descent rate, and if it above centre you should slow your descent rate. The HSI tooltip contains context information about your position on the profile.

Full scale deflection on the profile bar is 1 degree above or below the profile (the same as a normal ILS). This mimics the standard handheld Garmin (e.g. 296, or 496) VNAV functionality. If you wish to disable the profile bar, set the Profile to 0ft/minute, accessed from the “File” Tab in Options/GPS Panel.

13.5 Traffic

The Traffic data expander shows a table of all the FSX/FS9 AI or online traffic within a defined distance of the user aircraft. The maximum distance for the display of AI traffic can be user-defined in the Global Options. The default setting is 50 nautical miles.
If you are connected to VATSIM, IVAO or other online or multiplayer server, then Plan-G displays other connected aircraft rather than AI aircraft.

13.6 Trail Analysis

This is enabled from the “File” tab, in Options /User Aircraft (See section 8.5.6 above). It allows the user to log his/her aircraft’s trail, or “track made good”.

If the option is checked, the trail of the user aircraft is saved for every flight, and shows the aircraft flown, the path, and the time at each waypoint. The start and end-times for the trail segment displayed can be set with the slider at the bottom of the display.

The trail shown in Figure 48 shows a Cessna 152 en route from Gloucester to Shobdon in the UK Midlands.

Clicking on the Vertical Profile button (shown arrowed in Figure 49 below) in the Trail Analysis Expander opens the Vertical Profile Review window, where the recorded actual elevation of the flight is displayed.
To hide the vertical Profile display again, click the conventional Windows ‘Close’ button at the top right of the window.

13.7 Aerodrome

If you right-click an airport on the map and select “Show Airport Chart” from the dropdown, the Aerodrome Diagram is displayed. You can use the mouse wheel to zoom in/out, and if you hover the mouse pointer over the parking spots, runways & taxiways the relevant details are displayed.

The diagram can also be displayed in its own “tool window”. To see how to do this, go to section 12.4 above.

13.8 Information

By default, this panel is shown expanded. It provides important information (as its title implies) about the feature currently beneath the mouse pointer. This may be aerodrome data, (active or disused), controlled airspace data (name, type and boundary
altitudes) or radio navigation aids type and frequencies, or all of these, for example, at a major airport. The Maximum Elevation Figure (MEF) for the mouse cursor location is always displayed.

As the mouse pointer moves, so it constantly changes, so you can check out such information to help create a flight plan, e.g. avoiding certain controlled airspace.

The information displayed can be locked so that the data for a particular area is constantly displayed even though the mouse pointer is moved away. See section 14.1.1 below for details.
14 CONTEXT MENU OPTIONS

Context menus with appropriate options are available in Plan-G when you right-click on various elements of the display.

14.1 Right-Click on the Map

If you right-click on any part of the map a dropdown menu is displayed containing several commonly used functions.

![Figure 51 Right-Click Map Dropdown Menu](image)

14.1.1 Create User Waypoint

You can create custom waypoints anywhere you like on the map without restriction. This is particularly useful for VFR flight where towns, lakes, hills and other features are requires as points of navigational reference.

This subject is dealt with in detail in section 15.2.1 below.

14.1.2 Spot Elevation

If the user has downloaded the optional Digital Elevation Model (DEM) tiles from the NGDC 'GLOBE' (Global Land One-km Base Elevation) website (see section 12.1 above), then Plan-G will display the elevation above sea level of the point which has been right-clicked as the second item on the right-click dropdown menu.

14.1.3 Display and Hide Range Rings

Place the ‘hand’ cursor at the point on the map where you want the range rings to be centred, and right click. Select “Display Range Rings” from the dropdown menu.

If you want to move them, simply move the cursor to the new location and select “Display Range Rings” again.

To hide the range rings, right click anywhere on the map and select “Hide Range Rings from the dropdown menu. Range rings are hidden by default, so if you exit Plan-G, they will not be displayed when you re-start the application.

Range rings can be set to display in units of distance or time. If time is chosen, the rings will automatically be distorted to take account of any wind entered in the Winds dialogue box (see sections 9.6 and 15.1.2).

Range rings do not require you to be connected to FS. They are purely a mapping display function. You can only display one set of rings.
14.1.4 QDM Range and Bearing

In the early days of radio, when transmission was carried out entirely in morse code, the “Q-Code” was a series of letter groups starting with Q, each of which had a specific meaning. A few, including QNH, QFE and QDM are still used in aviation. QDM means "What is the Range and Bearing TO a distant point FROM a fixed origin – in this case the User’s Aircraft. For completeness, you should know that the Bearing FROM a distant point to your aircraft is QDR. It is sometimes used by real world pilots.

Place the ‘hand’ cursor at the point on the map to which you want to know the bearing and distance from your aircraft, and right click to display the dropdown menu (see Figure 54 below). Select "QDM: Range and Bearing". A red line will be drawn from the right-click point to the mouse cursor, with the range and bearing values displayed in the Information Panel.

Right-clicking any point again will show a check mark on the dropdown menu against the QDM: Range and Bearing line, indicating that QDM Line drawing is ON. Clicking on "QDM: Range and Bearing" again on the dropdown menu will remove the check mark and turn OFF the QDM line.
If you wish to draw a new line, then with the present line displayed, right click on the new point you wish to measure from. The dropdown menu will be displayed again, but if you right click on the map at any point away from the menu, it will disappear and the new line will be drawn from the point you selected to measure from.

14.1.5 Lock Info Panel

The information displayed on the Information Panel as you move the mouse round the map can be locked so that the data for a particular area is constantly displayed even though the mouse pointer is moved away. To lock information, hover the mouse over the area on the map which displays the information required, then right click and select “Lock Info Panel” from the dropdown.

![Figure 54 Lock the Info Panel](image1)

![Figure 55 Unlock the Info Panel](image2)

To return to changing data as the mouse is moved, right click and select “Unlock Info Panel”.

14.2 Right Click on an Airport

Right clicking the mouse on an airport symbol opens a different menu from the one which is displayed when you right click on the map. It shows some options specific to that airport and some which also appear on the map right-click menu. The options are described below.

![Figure 56 Right-click on Airport](image3)

14.2.1 Start Flight Plan at Airport

Right-click on the departure airport on your plan, “Start flight plan at airport <ICAO code>” (Plan-G fills in the ICAO four-letter code for the selected airport) is self explanatory. If you right-click an airport after your departure airport, this option changes to “Add airport <ICAO Code> to plan
14.2.2 Select Airport as Alternate
What if you arrive at your destination and you cannot land there? In the real world, there can be many reasons for this, but in FS, especially when flying on line with VATSIM or IVAO, etc., there may be an aircraft already on the runway which does not move as you fly your final approach. You clearly have to land somewhere, and that is what the “Alternate” box is for in the online flying pilot client flight plans (though it does not feature in FS created flight plans).

If you select this option, an additional line, but in red, is drawn on the plan from your destination to the airport you select as your alternate. Importantly, because you don’t want to be doing this while going around because of that unmoving aircraft, the plan displayed in the Expander panel includes the distance, heading and time, etc. to your alternate from your destination. The line of data for the destination to alternate leg is shown in red.

Note: The alternate heading and distance is always calculated from your destination, because standard aeronautical practice worldwide assumes that you fly to your destination before diverting to your alternate.

14.2.3 Show Airport Chart
If you select “Show Airport Chart” from the dropdown menu, the Aerodrome Diagram is displayed. You can use the mouse wheel to zoom in/out, and if you hover the mouse pointer over the parking spots, runways & taxiways the relevant details are displayed.

You can also show it in its own “Tool Window” as described in section 12.4 above.

14.2.4 Instrument Approaches
If an airport has instrument approaches built into FS, then there is a menu option in the airport right-click dropdown to display them. They are much simplified versions of real world Instrument Approach Plates, but if you are unfamiliar with instrument approaches, then you will want to know what the diagrams mean.

When you first click on the Instrument Approach option, there may be a pause while Plan-G loads the information, then a small “Approaches” window is displayed showing all the approach procedures available for that airport in FS. (There may be several others available for real world flight.)

The window is split in two by a black divider bearing the word “Transitions”. If you click on one of the displayed approach procedures, two things happen:

- A blue line and a red line appear overlaid on the Plan-G map at the airport
- Some codes appear below the “Transitions” divider in the Approaches box.

The blue line is the track the aircraft should be flying inbound to the airport on the runway heading, approaching the Final Approach Point (FAP). In the UK, this is typically between 4 and 7 nautical miles from touchdown, depending on how cramped the airspace is around the airport. In the USA and Canada, where congested airspace is less of a problem, this can be 10 or more nm from touchdown.

The red line is the Missed Approach track. If you do not have the runway in sight by about 2/3rds of a nautical mile before touchdown (200ft above the airfield elevation),
called the Missed Approach Point (MAP), then you must carry out a Missed Approach. As illustrated, you fly the runway heading outbound for 3 or 4 nautical miles, climbing to, typically, 1,500 feet above the airfield elevation, then make a rate one turn inbound back to the beacon.

The codes below the “Transitions” divider, in the lower half of the Approaches window, may be 2, 3, 4 or 5 characters, and are the ICAO identifiers for the transition points. Typically, if a transition point is an NDB, it will be two letters, a VOR, three letters and so on.

If you click on one of the Transition Points, then the blue line gains an extra line, which is the lead in from the Transition point to the Initial Approach Fix (IAF) and continuing on to the FAP. It may be a “procedural turn”, which is typically teardrop shaped, or an inbound track from a VOR to the FAP.

The transition points are the points at which your en route navigation ceases and you begin to fly the Instrument Approach Procedure (IAP) or “the procedure” as it is popularly known. Transition points will always be a VOR, an NDB, or an intersection (see section 10.4 above for an explanation of an intersection). If the transition point is an NDB or VOR located on the airfield, (e.g. Manchester) then the procedure will be a procedural turn. If, as is sometimes found, there is an NDB on the runway extended centreline and approximately 3 nautical miles from the threshold, (e.g. East Midlands), the transition point, and the IAF, will both be the NDB, and the procedure will start from there.

FSX includes RNAV approach procedures for the USA and Canada, but UK transition points will almost always be VORs or NDBs.

14.2.5 METAR

One of the minor miracles of Plan-G is its ability to fetch both the current real world weather (METAR) and forecast weather (TAF) for any airport within its database which has an associated weather station. For airports which do not have an associated weather station, or for which there is no current information, Plan-G displays no weather, rather than use the nearest available.

Note: the "Download Weather from NWS" option must be set (access via the File tab, in Options/Weather), for METARS and TAFs to be shown. There is a short delay after initial startup before weather data is available.

14.2.6 Other Selections

The other selections in the Airport right-click dropdown are:

- Spot Elevation
- Display Range Rings
- Hide range Rings
- QDM range and Bearing

These options are also available on the Map right-click dropdown and are described in section 14.1 above which deal with that function.
14.3 Right-Click on the ‘Plan’ Expander

The dropdown menu here displays a number of options for modifying your plan.

14.3.1 Set This as the Active Leg

Clicking this option sets the 'active' leg for calculating time & distance to next waypoint. It is only useful if connected to FS and where you may have opened a flight plan part way through a flight. Setting a new active leg allows you to “pick up” the leg in the flight on the flight plan which your aircraft is currently flying. Put another way, (and it is not exact of course) it “sort of” synchronises your flight to the plan. It can also be useful if

- The pilot misses a waypoint completely, and wants to tell Plan-G to forget pointing to the last waypoint, but to now help get to the next one, or
- The flight plan has been changed mid-flight, or
- The leg sequencing goes awry in Plan-G for some reason

14.3.2 Centre on Map

If you right click on a waypoint in the plan, the map moves to position that waypoint in the centre of the map.

14.3.3 Move or Delete Waypoint

Waypoints can be moved up or down in the table, or deleted from the plan. Right click the entry in the table you wish to move or delete, and select the appropriate menu option from the dropdown. See Figure 57 below.

Figure 57 Flight Plan Waypoint Dropdown Options

14.3.4 Cross References

Cross references are useful for defining a waypoint precisely using vector geometry. For the non-mathematically inclined, it means that any point on a map can be precisely identified by an angle and distance from a point. You can also get a “fix” if you have only the angle from two known points relative to a common axis. That principle is called “Triangulation”. In aviation, the angle is of course the Magnetic Bearing from the waypoint (QDR) and the common axis is Magnetic North.

In flight, if a pilot tunes in a VOR on his NAV1 radio, then turns the Omni-bearing selector (OBS) until the CDI needle is centred and the “TO” flag is displayed, and also observing the DME instrument, the pilot is able to obtain a “position fix” for the aircraft,
which will be, for example 262° TO the VOR (i.e. broadly to the west of the aircraft) and 22.4 miles from it. In other words, The QDM of the Aircraft to the VOR is 262°.

By selecting a second VOR within range and carrying out the same exercise, the position fix may be confirmed, or the accuracy of the pilot’s rough plot on the chart improved (remember he/she is flying the aircraft at the same time!) Ideally the radials from the two VORs should intersect as nearly at right angles as possible.

**Figure 58 Position fix from two VORs**

In Plan-G, if you select “Cross References”, you can enter two radio Navaids in the dialogue box which opens. Click the “Add” button for the first cross reference then select the table you wish to search – either VOR or NDB, by clicking the appropriate tab at the top of the window. Now select a Navaid, either by typing in the ICAO Identifier, e.g. BPK for Brookmans Park VOR, or pick the one you need by scrolling down the (very long, worldwide) database of Navaids displayed.

The vector lines are drawn on the map, and the bearing TO the Navaid (QDM remember) and distance are shown in the flight plan in the Expander panel, and included in the Pilot’s Log (PLOG). To use this information to arrive at the waypoint, you need to turn the Omni-bearing selector (OBS) until the “TO” flag is displayed, and the CDI needle is centred. Note the bearing indicated at the top of the instrument. Turn the OBS again until the Plan-G QDM is indicated and fly a closing heading until the CDI needle is again centred. Observe the distance on the DME instrument and turn onto the QDM heading, keeping the CDI needle centred until the Plan-G distance is displayed on the DME. Then you will be at the waypoint. For example: the Plan-G QDM is 262° and you are flying heading 030°. Turn the OBS to 262°, turn the aircraft 90° to it – 352° and then turn heading 262° as the needle starts to centre. (see section 14.1.4 above for an explanation of “Q codes”).

When using two NDBs for cross references, Plan-G is a bit smarter than real world NDBs, because it provides distance information, which real world NDBs do not. If you use two NDBs in the real world your fix is provided entirely by the intersection of the two indicated ADF bearings.

**Warning:** Make sure if you enter an ICAO code that you have selected the correct waypoint type. In the screenshot below, someone selected “CAM” for the Cambridge
NDB, but from the VOR table, and got a silly result -2,918nm! The CAM VOR happens to be near Schenectady, New York State, USA, not near Cambridge, England! It is the CAM NDB which is on Cambridge (UK) Aerodrome!

**Figure 59 The Wrong CAM!**

14.3.5 Add Alternate

This option is described at section 14.2.2 above.

14.3.6 Set Author

If you want to be recognised as the world leader in creating Plan-G flight plans, then click this option and enter your name in the dialogue box. Now when you send your plans to others, your fame will go with you.
15 FLIGHT PLANS

This section describes the all important procedures for creating, amending, saving, loading and deleting flight plans. There are two basic methods of creating flight plans:

a) Graphical
b) Tabular

15.1 Creating a Flight Plan Graphically

This method is intuitive and fast, and will almost certainly be the choice of most users for creating a new flight plan.

15.1.1 New Flight Plan

To start, clear the flight plan memory of any existing plan by clicking the “File” tab at the top left of the main Plan-G window to open the drop-down menu, then click on “New Plan”. This clears the flight plan memory and expands the Plan Data Expander on the right of the map, although at this point that may not be obvious, because it contains no data. There are other important items in the File tab menu which will be described later.

Alternatively, click the "blank sheet" icon in the Quick Access Toolbar, which achieves the same result. If no flight plan is loaded, then there is no visible result from either of these two actions. However if a Flight Plan is already loaded, and the map is showing the waypoints and legs of that existing plan, those legs and waypoints will be erased, but the map location will remain centred on the same position as for that plan until the User changes the map view with the usual tools.

15.1.2 Flight Conditions

The “Home” ribbon menu contains the options you need to set up the conditions for your new flight plan. The selections made here are used to calculate the headings and elapsed leg times in the Flight Plan, and are dynamically adjusted in the Plan expander on the right of the map window if you make changes. These conditions are saved to your new Flight Plan when you click the "Save" or “Save As” buttons.

Cruising airspeed, Altitude, Wind and VFR or IFR can be entered before drawing the plan, but Start Position (e.g. Parking, Ramp, Active Runway) can only be entered once the start location of a flight plan has been created (see section 15.1.5 below).

![Flight Plan Conditions](image)

*Figure 60 Setting Flight Plan Conditions*

15.1.3 Departure Airport

Now find your departure airport on the map. If it is visible on the current map, then move the mouse pointer over the airport icon, and right-click.
Select “Start flight plan at airport <ICAO code>". (Plan-G fills in the ICAO four-letter code for the selected airport).

**Figure 61 Right-Click Dropdown - Start Flight Plan from Here**

If it is not visible on or near the current map display, you can zoom out or pan by dragging the map using the Google map tools. Alternatively, you can click on the “Find” button on the Home menu ribbon (far left).

The "Find" button allows you to search for an airport or radio navigation aid. Clicking on the "Find" button drops down a list of objects you can search for:

- Find Airport (Search by ICAO code, by airport name, or by city name)
- Find NDB (Search by 3-letter identifier or by name or partial name)
- Find VOR (Search by 3-letter identifier or by name or partial name)
- Find User VRP (User Visual Reference Points or User Waypoints) are other points of interest that can be created by the user and added to a Plan-G database.)

**Figure 62 Using the Find Function to Locate an Airport**

If the searched for item exists in your simulator’s database, it will be found, and the map will centre on it. Search text is NOT case sensitive.

**15.1.4 Continue to Add Waypoints**

You can now select from the map (or use the “Find” option as above), the next waypoint in your flight plan. Right-click on its icon, and select "Add <item> to plan" from the dropdown.
<item> can be an airport, an NDB, a VOR, a VRP and its name and ICAO are displayed in the menu, so that you know you selected the right one.

![Right-click Dropdown – Add Waypoint to Plan]

**Figure 63 Right-click Dropdown – Add Waypoint to Plan**

The map will now show a track line from your start location to the new waypoint, and the new waypoint will appear in the Plan table in the Expander Panel on the right of the map. Continue with each subsequent waypoint in the same way until you have added your arrival airport. At each step, the track line will update and each waypoint will be added to your Flight Plan.

Note that waypoints are added to the Plan in sequence, so if you decide to add an intermediate waypoint after you have “gone past it”, your track line will double back, which is probably not what you intend. See “Editing Flight Plans” below for the way to correct this.

If you click on an airport as a waypoint, the second option on the right-click dropdown is “Set Airport <ICAO> as Alternate”. See section 14.2.2 above for details on adding an alternate. It is good airmanship, if not mandatory, to always enter an alternate.

### 15.1.5 Start Position

A Start Position on your departure airfield can be entered once the Start Location of your plan has been created. Until then, Start Position is greyed out. One leg is defined as a departure location, plus an end location. The end location can be your first waypoint or, for direct flights, your destination location. You can of course complete your plan, be it a direct track plan, or one involving a number of waypoints, and add the Start Position at the end of the process just before saving the Plan.

![Move your Aircraft, but not to the Active!]

**Figure 64 Move your Aircraft, but not to the Active!**
If you add a start position in Plan-G and load your plan into Flight Simulator, then when FS asks if you want to move your aircraft to the departure airport listed on the flight plan, and provided you click “Yes” your aircraft is moved in FS, not to the active runway, which is the FS default, but to the start position you selected in Plan-G. If you are flying online, then this position should be a starting gate or GA ramp, and definitely NOT the active runway.

**Note:** To use this option, your plan must be saved as a .PLN file, though, not as a .PLG file, which will not load into FS.

### 15.1.6 Vertical Navigation
Building a vertical navigation profile by adding passing altitudes cannot be done graphically, but requires the parameters to be entered from the keyboard. It can be done by entering the details in the Plan (in the expander or in a tool window), once the flight plan route has been completed graphically. See section 15.3 below for full details.

### 15.1.7 Notes
Adding notes to a flight plan is carried out from the keyboard. It can be done by entering the details in the Plan (in the expander or in a tool window), once the flight plan route has been completed graphically. Open the Plan in the expander or in a tool window. Scroll across to the “Notes” column and double click the appropriate cell. You can now enter free text to add any important information for that leg of the route. The cell expands to accommodate the text entered.

### 15.1.8 Save your Plan
Once you are satisfied with the sequence of waypoints in the Plan table, save the plan as described in section 8.3.

### 15.1.9 The Reverse Button
This button automatically reverses the sequence of waypoints in a loaded flight plan and recalculates the bearings to create a new flight plan for the return trip, assuming you want to go back along the very same route. The window title in Plan-G will reflect a new name for the reversed flight plan, and when you save it, Plan-G automatically changes the name for the new, reversed plan.

### 15.2 Creating a Flight Plan by Data Entry
Although you may find it less intuitive, Plan-G nonetheless allows you to select waypoints directly in the drop-down Plan expander. This could be convenient, for example, when transcribing a flight plan from a printed form or a handbook. Press the "New Flight Plan" button to clear any loaded data from Plan-G. The departure airport must now be chosen in the usual way, by either right-clicking on its icon, or by using the "Find" menu at the top left of the Plan-G window. Now that there is a single waypoint in the new flight plan, the "Plan" expander can be opened. It will contain a single line for the departure airport at this point in the process.

### 15.2.1 Inserting Waypoints into the Tabular Plan
The next waypoint, or the destination airport, can now be entered into the table. Right-click on the table entry for the departure airport, and select "Insert Waypoint Below".
This pops up an "Add Waypoint" panel, where you can select the type of waypoint (Airports/VORs/NDBs/User VRPs). The waypoint to be inserted can be found either by its ICAO code or by its common name. If you enter the first few letters of the name or ICAO code, Plan-G will display only those entries in the database starting with those letters.

Once the desired waypoint is found, clicking on "OK" will insert it into the Plan table, and also on the Plan-G map, with an associated track line. If necessary, waypoints can be moved up or down in the table, or deleted from the plan.

15.2.2 Notes
Open the Plan in the expander or in a tool window. Scroll across to the “Notes” column and double click the appropriate cell. You can now enter free text to add any important information for that leg of the route. The cell expands to accommodate the text entered.

15.2.3 Save Your Plan
Once you are satisfied with the all the information in the Plan table, save the plan in the usual way.

Note: that if you save it as a .PLN file for use within Flight Simulator, cross references, passing altitudes and notes cannot be saved. All these are included in saved .PLG files.

15.3 Vertical Navigation
15.3.1 User Defined VNAV Profile
You can build a custom vertical navigation (VNAV) profile in Plan-G if you wish. At key waypoints, where altitude is critical, such as controlled airspace boundaries or high terrain, you can fix the altitude to fly. Load a flight plan and open the tabular plan in either the Data Expanders or as a Tool Window. Scroll across to the right of the plan to the “Passing Alt.” column. Double click the appropriate cell in the column and enter the desired altitude. Enter the value without a comma separator for 000s, although if you do include a comma separator, Plan-G will remove it.

If you now open the Plan Elevation window, you will see your Vertical Navigation Profile displayed as a solid orange line. If the Plan Elevation Window is open when you enter passing altitudes, the VNAV profile is not displayed until you close and reopen it.
15.3.2 Default VNAV Profile

If you choose not to build a vertical navigation profile, Plan-G builds a default one anyway, based on the diagram below.

![Vertical Navigation Profile Diagram](image)

Figure 66 Vertical Navigation Profile Diagram

Plan-G calculates a Top of Descent (ToD) point based on your altitude and true airspeed. For example, if you are flying at 120 knots (2nm per minute) at 3,000ft, and the rate of descent is set at 500ft per minute, then to descend to 1000ft will take 4 minutes, in which time you will have travelled 8 nautical miles. The target position is normally 1000ft above the destination and 3 miles before it – i.e. at circuit height and in a comfortable position to join the visual circuit. So the ToD point in this case would be 11nm from your destination.

One minute before the ToD point an alert sound and popup message, “One minute to VNAV Profile” is displayed. In the example above, this would be 12nm before touchdown.

A second alert sounds 500ft above the target altitude, and a further popup “500ft to target altitude” is displayed.

The vertical navigation profile parameters are all user configurable via the File tab, in Options/GPS Panel, see section 8.5.5 above).

15.4 Modifying Existing Flight Plans

With a previously-created flight plan opened in Plan-G, you can either:

- Add one or more waypoints to the end of the existing chain of waypoints,
- Insert a new waypoint between two existing waypoints.
15.4.1 Adding a New Waypoint to the End of a Plan

Adding a new waypoint to the end of the sequence is just a matter of right-clicking it and selecting "Add <waypoint ID> to plan". You then "Save" or "Save As" the changed flight plan, as described above.

15.4.2 Inserting a New Waypoint

There are two ways to insert a waypoint between two others in a flight plan.

a) Right-click on an entry in the tabular plan, and select ‘Insert waypoint above’ (or below).

b) Using the ‘Edit’ button on the “Home” ribbon.

15.4.3 Inserting a Waypoint into the Tabular Plan

Right-click on the table entry above or below which you wish to insert a new waypoint. Select either "Insert Waypoint Below" or "Insert Waypoint Above" according to where you wish to insert the new waypoint.

This pops up an "Insert Waypoint" dialogue, where you can select the type of waypoint to be inserted (Airports/VORs/NDBs/User VRPs).

The waypoint to be inserted can be found either by entering its ICAO code or by entering its common name. If you enter the first few letters of the name or ICAO code, Plan-G will display only those entries in the database starting with those letters. If the desired waypoint is found in the Plan-G database, as you type, Plan-G will find all relevant entries and display them below the entry line. Select the one you want (often there will be only one if you enter a unique identifier) by clicking on it to highlight it, then click ‘OK’. Clicking "OK" will insert it into the Plan table, and, if it is a pre-defined User Waypoint, show it on the Plan-G map, and will move the track line to match the order of entries in the table.

![Insert Waypoint Dialogue](image)

**Figure 67 Inserting a Waypoint**

15.4.4 Moving and Deleting Waypoints

You can of course move waypoints up or down in the table, or delete them. See section 14.3.3 above for details.
15.4.5 Save Your Edited Plan

If you have edited your Flight Plan by adding or inserting new waypoints, for example, and wish to keep the original as well, then go to the File Tab and select “Save As”, select either a .PLG or a .PLN file, and give the modified plan a new name.

15.5 Using the ‘Edit’ Button

When the ‘Edit’ button is pressed, click-drag-release editing is possible on the track line of your flight plan. First load the flight plan you wish to modify, if it is not already loaded. Find the ‘Edit’ button in the middle of the Home Ribbon. If you click that button, it changes colour to an orange background, indicating that ‘edit’ mode is active.

Look at your flight plan on the map and you will see small square grey drag handles in the middle of each leg of the track line of the displayed flight plan. If you have a long leg between waypoints, you may need to drag or zoom the map in order to see the drag handle on that leg. Note that these are the same shape as waypoint icons, but are grey rather than white, so be careful to select the correct icon.

If you hover your mouse pointer, which will be a standard Windows drag-hand icon, over one of these drag handles the drag-hand icon changes to a select-hand icon. Be sure to choose a zoom level at which the drag handle is easily selected. Then, left-click
and drag the handle to the waypoint you want to insert in your plan. The new waypoint can be a named object such as a "User Waypoint", an airport, VOR or NDB. Alternatively, if you drag the drag-handle to an unidentified point on the map, the inserted waypoint will have no icon of its own, and Plan-G will add it to the plan in the expanded data area with a default name, wpt01, wpt02, etc.

You can create a user waypoint at that point, but Plan-G will not automatically add your new User Waypoint. You must add it to the plan by again dragging the appropriate drag-handle to the new user waypoint. To avoid confusion and clutter, you should delete the default one from the Plan by selecting it in the tabular plan, right clicking on it and selecting “Delete waypoint”.

These waypoints are only "temporary" - they are added to the flight plan but not to the User Waypoints database. They are saved with the plan and redisplayed if you reload that plan, but if you create a new plan, they will not be present. If you right-click a temporary user waypoint on the tabular plan, there is an option in the dropdown menu to rename it, if you wish.
16 USER WAYPOINTS

Plan-G builds an internal database (PlanG_FSX.sdf or PlanG_FS9.sdf) of airports and navaids based on a scan of the FS scenery configuration file. User Waypoints together with official “Visual Reference Points” are contained in a separate database within Plan-G, namely, UserWaypoints.sdf. Plan-G includes a large number of pre-defined User Waypoints, and you can also add your own.

Figure 69 The User Waypoint Database

16.1 Creating User Waypoints

You can create custom waypoints anywhere you like on the map without restriction. This is particularly useful for VFR flight where towns, lakes, hills and other features are required as points of navigational reference.

Right click the map at the point where you want to create a user waypoint to display the dropdown menu which includes the Create User Waypoint option.

Figure 70 User Waypoint Dropdown

Click the Create User waypoint option and a dialogue window opens for you to enter the details.
Enter the waypoint name and an identifying code - which can be up to 8 characters in length. The magnetic variation (MagVar) at that point and the Latitude and Longitude are automatically added by Plan-G, but you can edit them to fine tune a waypoint position to an exact spot if your mouse clicking isn’t so accurate.

If the appropriate DEM files are installed (as described in Section 12.1 above), Plan-G will automatically fill in the Elevation for the new User Waypoint.

Click “OK” to save the waypoint.

The waypoint appears as a small green circle on the map (Figure 72 above).

The waypoint is saved in the User Waypoint Database which can be manipulated in a similar way to a spreadsheet (see section 16.5 below).
16.2 Adding a New User Waypoint to the Flight Plan

Right click the new User Waypoint on the Map, and the name of the waypoint will be displayed in the menu, as part of an “add to flight plan” option.

Select this option and the waypoint is added to the Flight Plan. The new waypoint is added as the last item, and the track line will then show a route which you probably don’t intend to fly. Right click on the flight plan to display the dropdown menu which allows you to move the new waypoint into its correct position. The track line will adjust accordingly. (See section 15.4.4 above for more on editing flight plans.)

16.3 Modifying User Waypoints

You may wish to move a waypoint slightly, change its name or identifier. If you right click on the new waypoint, the dropdown has three new items which are reasonably
self-explanatory. If you select “Edit User Waypoint” the Create User Waypoint dialogue is again displayed, although now with the window title “Edit User Waypoint” at the top.

You can make changes directly in the text boxes, including moving the waypoint by changing the Latitude and/or Longitude values.

![Image of Edit User Waypoint dialogue]

**Figure 75 Editing a User Waypoint**

If you rename a waypoint that is included in the current flight plan, the plan will be updated to reflect the change. Any plan that is not currently open will, of course, not be updated.

16.4 **Deleting User Waypoints**

To delete a User Waypoint, right click on the new waypoint, and select “Delete User Waypoint” from the dropdown menu. The waypoint is immediately removed from the database, and the map, but not from the current flight plan or its track line on the map.

Alternatively, you can locate the User Waypoint in the User Waypoint Database table (See Figure 76 below), highlight the record with a single mouse click, then press the “DEL” key on the keyboard. The deletion is not reversible, therefore a warning is displayed “This action will delete row(s) from the database. Do you wish to proceed?” as a protection against accidental deletion.

16.5 **Managing the User Waypoint Database**

To view the User Waypoint database and manage it directly, (adding, editing or deleting waypoints, open the Data Ribbon at the top of Plan-G, and select the Manage Database button. The “Manage User Waypoints” window will open.

If you double click in any “cell” in the database, it is highlighted in white and surrounded by a heavy black border. The text or numerical value in that cell can then be changed. Clicking “OK” will save the changes.
Records can be deleted by selecting them with a single mouse click and pressing the keyboard “DEL” key. A single row or multiple highlighted rows can be deleted with one key press. The deletion is not reversible, therefore a warning is displayed “This action will delete row(s) from the database. Do you wish to proceed?” as a protection against accidental deletion.

16.6 Importing and Exporting Records

You can import or export data files containing user waypoints so long as the number of fields matches exactly the number of fields in the User Waypoint database (9). These files must be comma separated value (CSV) files of the form

[CATEGORY],[NAME],[IDENTIFIER],[LATITUDE],[LONGITUDE],[ELEVATION],[MAGVAR],[TAG],[NOTES]

e.g.

VRP,BOLAM LAKE,NEWCASTLE,55.125497253418,-.8713300304413,0,4,UK,

Note the order of fields that you must create isn’t exactly as displayed in the Plan-G User Waypoint Database. Also note that the final comma denotes that the 9th field [NOTES] is empty in the example above, but must be accounted for by that final comma after “UK”. In other words, in any record you wish to import, you must have 8 commas otherwise the import will fail.

With the User Waypoint Window open, highlight the records you wish to export and only those will be exported. Non-contiguous records can be selected by holding down the Ctrl key as you click each record.
17 AN EXAMPLE FLIGHT PLAN

Much of Plan-G is intuitive. You don’t need this comprehensive manual at all. However, for those who don’t have time to read manuals, but just want to get going, here is a worked example of a short VFR flight across some of England’s most beautiful and famous landscapes. It introduces as many features of Plan-G that can be reasonably packed into a short 115 mile flight.

17.1 Preparation

Just as in the real world, there is a significant amount of preparation required before flight. Of course we will start by creating a flight plan in Plan-G.

1. Open Plan-G and on the Home Tab, click “Find”.
2. Select Airport from the dropdown and enter EGNC in the ICAO Code box.
3. Carlisle will be highlighted. Click OK.
4. On the map, close the callout box containing the airport name and ICAO.
5. Right-click the airport icon and select “Start Flight Plan at airport EGNC”
6. Now set up the flight conditions. Open the Home Ribbon by clicking the Home tab, and then click Altitude, and set 4,000 feet.
7. Select Airspeed, and enter 100 knots for the default Cessna 172.
8. Now that you have a Start Location, you can now add a Start Position for your aircraft at Carlisle. In FS, you have already selected PARKING 1 - RAMP GA SMALL, so from the Home Ribbon, select “Start Position”. From the options
shown in the pop-up “Set Airport Start Position” window which appears, select PARKING 1 -- RAMP GA SMALL again, and click OK.

17.2 The Scenic Route

You have established the flight pre-conditions and now it is time to plot the route to Liverpool.

1. Find the Wigton VRP to the south-west of Carlisle. Right click and select “Add User Waypoint CARLISLE WIGTON to the plan. (Wigton is a Visual Reference Point and included in the default Plan-G database, although it is called a User waypoint).

2. If you do not have photographic scenery for the UK, Wigton (the town) will not be obvious, so you may wish to add a Cross Reference to it from Dean Cross VOR. Right-click the Wigton VRP symbol and select “Set Waypoint Cross References”

3. In the Cross reference window, click “Add” for the first point, and enter “DCS” in the entry box. Select the Dean Cross (the only) entry, and click OK

4. Observe the Cross reference red line from Wigton to Dean Cross VOR. In the plan, note the bearing and distance. Compare your present bearing and distance from Dean Cross VOR to find which way to fly to arrive overhead Wigton.

5. From Wigton, you will fly over Keswick and admire the beauty of the Lake District. You need to create a User Waypoint for Keswick (pronounced Kezzik, by the way). You will find Keswick to the south east of Dean Cross, on the south side of Bassenthwaite Lake and just north of Derwentwater.

6. Right click on the name Keswick shown on the map, and complete the User waypoint Dialogue box. Check that “Location” is set as the waypoint type. Enter Keswick Town in the Name box, and KESWK in the Identifier box. In the tag box, you could enter your initials to indicate that it is one of your user-created waypoints.

7. Click OK and observe the small green waypoint circle appear on the plan.

8. Now you can add another leg to the plan. Right click your new waypoint and Select the option “Add user waypoint KESWK Keswick Town to the Plan”

Note that the newly added track line goes over some impressive looking high ground. It is in fact Skiddaw, at 3,052 feet, the 4th highest mountain in England. If you have downloaded the Digital Elevation Model (DEM) tiles from the NGDC 'GLOBE' (Global Land One-km Base Elevation) website at http://www.ngdc.noaa.gov/mgg/topo/gltiles.html you can now look at what this means in terms of vertical navigation. (See section 12.1 for details of DEM.) If you haven’t downloaded the DEM tile for the UK, you really ought to. It adds a great feature to Plan-G. You need tile B, filename b10g.gz which covers 90% of the UK.

9. So you now have the DEM info installed. Open the View Ribbon, by clicking the View tab, and tick the Plan Elevation Tick box at the top left of the ribbon.
10. Whoa! That is some mountain (in UK terms anyway) 24 nautical miles en route. Move the mouse pointer and find the highest point of the mountain, the Maximum Elevation Figure (MEF) and the Suggested Altitude). If you have forgotten how to do this, see 12.1 section above. You should get 2605, 2994 and 3959 feet respectively. You will now realise why the planned altitude was 4,000 feet.

11. Now zoom the map to Level 11 and find the location which is Latitude N54° 27.00’ Longitude W003° 12.00’ using the map graticule. Zoom using the Google Maps zoom slider, or the Map Ribbon zoom buttons as you wish. To switch the graticule on (if it is off) go to the View tab and tick the “Map Graticule” tick box.

12. Looking at the Google map scale indicator at lower left (2 miles is just over a centimetre at level 11), from the latitude and longitude you have found, estimate 0.5 miles west and 0.1 mile north, and create another user waypoint at the top of the mountain. This is the top of England’s highest mountain, Scafell Pike, at 3,210 feet. Call the waypoint Scafell Pike, with the Identifier SCAFLL. The elevation of your waypoint should be 3,100 feet.

13. **Figure 79 Over the Lakeland Hills**

14. Add Scafell Pike to your route, as before. When you fly this route, alongside Bassenthwaite Lake, overhead Derwentwater and down the Borrowdale Valley to Scafell Pike, you will find the view hereabouts quite spectacular in default scenery, but with a good mesh and photographic scenery – simply stunning.

15. You now want to head more west to Seascale, Latitude N54° 24.00’ Longitude W003° 29.00’. But there are some things you need to watch out for. Open the Map ribbon, and look at the “Airspace” group of options. Switch on “Below 10,000 feet”, “Special Use 1” and “Special Use 2”.

16. That looks ominous. There is a large orange circle around Seascale itself, and just south of that, a very large red area. Click on the edge of the orange circle. In the Information Expander, you will see “Restricted Area Sellafield SFC-2200”. You cannot overfly one of Britain’s oldest and most famous Nuclear Power Stations below 2,200 feet.

17. But note also, that if you move the mouse into the open area a little to the east, you cannot fly above 5,500 feet because that is the Warton Radar Advisory Service Area. You must contact Warton Radar for permission to fly up there. (Warton is an RAF station just south east of Blackpool).

18. The big red area is Eskmeals Danger Area from the surface upwards to the stratosphere (SFC+). Eskmeals is (or was) a naval gun testing range where they fire(d) big shells out to sea. Avoid!
19. It might be a better plan to route direct from Scafell Pike to Barrow and look at nuclear submarines being built! Pan slowly down from Seascale and you will see Barrow Aerodrome and NDB. Add Barrow Aerodrome to your route.

![Figure 80 Sellafield and Eskmeals “Don’t Go There” Areas]

17.3 A Little Stick of Blackpool Rock

English comic singer George Formby made this song famous, along with his other risqué songs such as “With me little ukulele in me ‘and”. You are probably not interested in that, but to fly down the coast to Blackpool and beyond might be interesting.

1. From Barrow, looking south, you have the wide expanse of Morecambe Bay. The famous comedian Eric Morecambe took his stage name from the place. When the tide is out, this whole area is devoid of water; when the tide is in, it looks as if it does in FS, all water. The area is treacherous with quicksand, very fast flowing tides and channels so that anyone caught out on the sands on an incoming tide had better get out of there quickly. It has been the scene of many tragedies. In FS, where ditching in this dangerous area is not a consideration, you might as well plan to go straight across to Fleetwood Golf Course, a Visual Reference Point for Blackpool. Make sure you have Visual Reference Points enabled in the View ribbon, and right click the small orange circle to add Fleetwood to your route.

2. Fleetwood was once home to Britain’s second largest fishing fleet after Grimsby, but fishing has declined to near zero and the harbour today is populated by fancy yachts. If you intend to fly online and by chance Blackpool Approach is on duty, this is where you will make your initial call to them. “Request transit your overhead at 4,000 feet”. So you had better add Blackpool to your Plan now.

3. The trackline from Fleetwood to Blackpool is over land, but the “Left Hand Rule” for VFR flight states that if you are following a line feature, you should keep it on your left. This route is well used by light aircraft in the real world, who follow the convention of keeping the shoreline on the left. Thus southbound traffic flies a mile or so out to sea. Northbound traffic flies over the land. Although the trackline is over land, when you come to fly the route, you should do the same, passing a mile or so west of the 08 end of Blackpool’s main runway. Blackpool Approach will want you to call them at the “the tall tower”. They don’t say
“Blackpool Tower”, as you could well think they mean the building on the aerodrome, not the world famous 518ft high lattice steel structure a couple of miles further north.

4. After Blackpool, add Marshside VRP to your route; (you can do this now without help, surely) and then once more follow the coast to Woodvale.

5. Add Woodvale aerodrome to your plan. The airport symbol is red because it is a military (RAF in this case) aerodrome. The track line is again inland but you will want to fly on the seaward side of the shoreline.

6. So why not fly over Birkdale Sands, a beach airstrip which was first used for pleasure flights as long ago as 1919? [http://www.seftoncoast.org.uk/articles/01winter_aviation.html](http://www.seftoncoast.org.uk/articles/01winter_aviation.html)
   You can do this in two ways.

7. On the Home ribbon, select “Edit”. Find the small square in the middle of the track line from Blackpool to Woodvale, and drag it with the mouse to the small anchor symbol about halfway between Marshside VRP and Woodvale, which denotes Birkdale Sands (EGCO). To hit EGCO accurately, within its Plan-G “grab range”, you need zoom to be 13 or higher, otherwise you may find that you have created a temporary user waypoint instead. This will be shown in your plan as “wpt01”. If this happens, right click that line on your plan, select “delete waypoint” and try again. Now turn off “Edit” on the Home ribbon.

8. Alternatively, you can simply right-click Birkdale Sands to add it to your plan. The track line now goes from Marshside to Woodvale to Birkdale Sands, which is not what you want. So go to the Plan, right-click the new Birkdale Sands line, and select “Move waypoint up”. That has restored your route to something sensible.

9. Look now about 2.5 miles south of Woodvale. See the red line running horizontally across the map? Move the mouse to that line and read the information in the Expander. Here you are at 4,000 feet. Is there something you need to do?

### 17.4 Controlled Airspace

You are now getting close to Liverpool and things will change rapidly. You have planned to enjoy a leisurely flight with that great sense of freedom which flying (real or virtual) brings but what you will now have to plan for is controlled airspace and procedures. If you plan to fly on line, you will quite possibly have an ATC position manned – someone to talk to and give you instructions. The ATC instructions given in this manual are not absolutely correct, but are close enough for flight planning purposes. You should be familiar with correct ATC phraseology from other sources if you are planning to fly this route on line.

“Manchester TMA Class A 3500+” you should have read on the information expander in item 9 above. Flying VFR you absolutely cannot go there, so you must plan to descend. About 6 miles further south again is the Liverpool Control Area (CTA) which extends from the surface to 2500 feet and is Class D airspace. You can go there, but only with permission. Because IFR traffic inbound to Liverpool approaches at 2,500 feet, and
required traffic separation is 1,000 feet IFR from VFR in Class D Airspace, you will be given the instruction from Liverpool Approach “not above 1,500 feet.” So you must plan to descend from 4,000 feet to 1,500 in 8 miles or so, about 4 minutes. A quick calculation, tells you that that is 650 feet a minute – quite a rapid descent in a light aircraft.

![Figure 81 Controlled Airspace (Red Lettering not in Plan-G)](image)

1. First, however, complete the next leg of the route. Find the Seaforth VRP just west of Bootle. Add Seaforth VRP to your plan. On a VFR flight, when you first contact ATC at Liverpool just after Woodvale, you will be told “Runway 27 in use, report at Seaforth, not above 1,500 feet”.

2. However, you intend to practice flying the ILS, so you will reply to ATC “negative, request vectors for the ILS”. That changes the ball game completely. You will now deemed to be flying IFR, but assume the controller needs some practice in managing procedures, so he is going to respond “ Negative vectors. Maintain 2,500 feet, and continue with the procedure for runway 27. Report beacon outbound.”

3. Plan-G can save you the trouble looking for those approach plates for planning. (You should have them handy when flying the route though). So now right-click on Liverpool Airport, and select “Instrument Approaches”. Select “ILS 27” from the pop-up window. There is your procedure on the map. Add the transition “2. LPL” which is the one for Category A aircraft (that’s you in your Cessna). It uses tighter radius turns and shorter distances, but is otherwise the same as 1.LPL. If you select 1.LPL temporarily you can see the difference.

4. The procedure starts at the LPL NDB, so you can fly direct from Woodvale to the NDB. No need to go via Seaforth, which is the VFR route, because you are now flying IFR. First, add the LPL NDB to your plan. This manual isn’t going to tell you how to fly the procedure, but just how to complete your plan to landing.

5. Delete the waypoint “Liverpool-Seaforth” from your plan, by right-clicking it’s entry and selecting “Delete Waypoint”. It is no longer relevant.
6. Now add Liverpool Airport to the plan. The track line will obscure the final approach path of the procedure, but that doesn’t matter. By the time you are established on the ILS, your need for Plan-G is, hopefully over. You have a complete route airport to airport.

17.5 VNAV Profile

The next task is to create a vertical navigation profile. You need to get safely over those mountains, yet descend in time to get under the Manchester TMA near Woodvale, and then be at 2,500ft on reaching the LPL NDB.

1. Go to the Plan in the Data Expander, and using the horizontal scroll bar if necessary, find the “Passing Alt” Column. It is reasonable to assume that climbing out of Carlisle at 500 feet per minute in your Cessna 172, that in the 13.9 miles to Wigton, you can easily reach 2,500ft. So double click in the cell on the row CARLISLE-WIGTON and type in 2500.
2. Move down to the Keswick row and double click the cell in the “Passing Alt” column. To make sure you clear Skiddaw and Scafell Pike, type in **4000**.

3. In the same way, enter **4000** for Fleetwood Golf Course VRP and Blackpool Airport EGNH.

4. Mindful of the Manchester TMA south of Woodvale, with its base at 3500ft, go to the Woodvale row and the “Passing Alt” column, and enter **2500**.

5. To fly the Liverpool 27 procedure for the ILS, you need to be at the LPL NDB at 2500 feet. So move down to the LPL row and the “Passing Alt” column, and enter **2500 again**.

6. Open the Plan Elevation window from the tick box on the View ribbon to see the vertical profile you have created. When you fly the route, you will get “Top of Descent” alerts a mile before Woodvale, and again a mile before reaching the LPL NDB.

![Figure 84 VNAV Profile is the Orange Line](image)

**17.6 Notes**

You have read in the Flight Plans section (section 15 above) about how to enter notes. It will be important not to forget to descend below the Manchester TMA floor south of Woodvale, and to remind yourself that after Wigton, you need to be at 4,000ft.

1. Scroll across to the right of the Plan table and in the Notes column for the Keswick Row, double click and enter **Continue climb to 4000ft**.

2. Then do the same for the Woodvale Row, double click and enter **Manchester TMA base 3500ft**.

Remember that passing altitudes, cross references and notes will be printed on your plog, and saved with your plan if you save the file as a .PLG file, but not if you save the file as a .PLN file.

**17.7 Alternate**

1. What if you cannot land at Liverpool? What if some VATSIM or IVAO newbie is plonked right on the runway and is disinclined to move. You need to add an “Alternate” to your plan – somewhere you can go to if Newbie is still there when you are a mile from touchdown rapidly approaching the Missed Approach Point!

2. Look around the map, and select somewhere suitable. RAF Sealand is closed, and anyway it was gliders only, Manchester won’t really welcome a slow Cessna 172, but Hawarden, just to the southwest of Chester, is G.A. friendly. Right click on Hawarden and select “Set EGNR as Alternate”. A red line is now drawn on the map from Liverpool. Hawarden (pronounced “Harden” by the way) was, in
VATSIM’s early years VATSIM UK’s busiest airport, with a controller on duty 7 nights a week.

So that is your planned flight, with some local knowledge thrown in to make it more interesting. In fact, if you don’t fly VFR often, you may have discovered that short VFR flights can be just as challenging as IFR flight across continents. When you fly the route, don’t forget to complete the task properly by taxiing to Liverpool’s General Aviation apron at the east end of the airport. Park on stand E_Parking 11 Ramp_GA_Medium, shut down and secure the aircraft.

If you need an Airport diagram to find out where E_Parking 11 Ramp_GA_Medium is, (it’s an FS parking spot, so won’t be shown on the official CAA Aerodrome Diagram, will it?) right click the airport symbol once more, and select “Aerodrome Chart”. If you can’t see it clearly, you can “mouse-wheel scroll” to make it bigger, or, in the View Ribbon, click the “Expanders” button, and select to show the airport in a Tool Window. (See section 13.7 above for details.) You can see the G.A. Apron with small blue circles for the parking stands.

![Figure 85 The Completed Plan](image)

**17.8 Let’s Go Flying**

You have printed out the Plog from Plan-G so it is time to go flying.
1. Open Flight Simulator, and select Free Flight from the Main Menu.
2. Set Country as United Kingdom, and select Current Location as Carlisle (EGNC).
3. Select Starting position PARKING 1 -- RAMP GA SMALL.
4. Select Aircraft type Cessna 172.
5. Set a suitable time and date for a daylight VFR flight.
6. Click Fly Now.
7. When the flight has loaded, save it as the default so that you can easily get back to this position if you need to.
8. Find the current weather for Newcastle EGNX (the nearest weather station to Carlisle) from an Internet Aviation Weather site, such as http://weather.noaa.gov/weather/coded.html.
9. Set the Newcastle wind, cloud and precipitation information in FS.
10. Alternatively, if you are a member of an online Flightsim community such as VATSIM or IVAO, simply connect to the service and the weather at Newcastle will be automatically loaded into FS.
11. Start up, taxi to the active and enjoy your flight over England’s highest mountains to England’s second most famous city.
18 CONNECTION TO FLIGHTSIMULATOR

Plan-G can be connected to a running Microsoft Flight Simulator (FS) session, either on the same machine or on another PC connected via a local area network. With Flight Simulator connected to Plan–G several of the Data Expander functions are enabled – Weather, GPS Panel, Traffic & Trail Analysis, which are otherwise inactive because they cannot receive any data. In addition, the user aircraft and any AI aircraft or other aircraft in a Multiplayer environment are also displayed, plus an information bar at the bottom of the map containing positional information.

18.1 Flight Data Transfer

The data passed to Plan-G includes:

1. As overlays on the basic Google Map:
   - User aircraft icon (yellow)
   - AI aircraft icons (smaller, red)
   - Multiuser aircraft icons (also small and red)
   - User Aircraft trail (default colour magenta)
   - Multiuser and AI trails (default colour red)
   - Fly-to Heading, distance and time en route from the user aircraft to any point on the map by simply right-click the point for which that information is required.

In the Data Expanders
   - FS Weather
   - GPS data (airspeed, heading, altitude, rate of climb/descent)
   - Traffic table (Multiuser & AI)
   - Trail Analysis

And in the bottom panel below the plan
   - Flight plan waypoint distance,
   - waypoint heading, and
   - course deviation
While Plan-G is connected to FS, the "Flight Simulator" caption under the Connect and Disconnect buttons on the Home ribbon will change to one of the following, according to the connection that has been made.

"FSX (SimConnect)"
"FSX (FSUIPC)"
"FS9 (FSUIPC)"

When you click the “Disconnect” icon, the caption returns to "Flight Simulator".

### 18.2 Communication Protocols

In order for Plan-G to communicate with FS, data has to be transferred using a specific set of rules – the communications protocol.

FS9 users will need Peter Dowson’s [free FSUIPC 3](http://www.schiratti.com/dowson.html) ("Flight Simulator Universal Inter-Process Communication") program to be able to connect to Plan-G, either on the same PC or over a network. FSUIPC may be downloaded from [http://www.schiratti.com/dowson.html](http://www.schiratti.com/dowson.html) free of charge.

FSX normally uses a special Microsoft interface protocol, SimConnect, for communicating with other Windows programs, either locally or across a network. See [http://msdn.microsoft.com/en-us/esp/cc835021.aspx](http://msdn.microsoft.com/en-us/esp/cc835021.aspx) for an introduction to SimConnect. SimConnect only works with FSX.

There are three data transfer protocols available in Plan-G for FSX and SimConnect: - Pipe, IPv4 and IPv6.

- Pipe is used only internally in a PC, but is the fastest of the three.
• IPv4 is used by Windows Vista, XP and earlier versions of Windows.
• IPv6 is installed in Windows Vista and Windows 7, (though it may not be enabled) and may optionally be installed in Windows XP.

Some Plan-G users are unable to get SimConnect working for various reasons. Therefore Plan-G has been designed to also communicate with FSX using Peter Dowson’s free FSUIPC 4, which is an updated version of FSUIPC 3 that uses SimConnect internally.
19 FLIGHT SIMULATOR AND PLAN-G ON THE SAME COMPUTER

This section will guide you through the configuration steps required to connect Plan-G to your FS session.

Recommendation: Plan-G does not always display correctly if FS is loaded after Plan-G. If you start FS and allow it to load fully before Plan-G, then reliable operation of Plan-G can be expected.

19.1 Connecting to FS9

This requires the freeware program FSUIPC described previously. The FSUIPC installer program copies a file called “FSUIPC.DLL” into the FS9/Modules folder. Peter Dowson provides very friendly and attentive support for his programs on this forum:


After installing FSUIPC, you will discover, when you run FS9, that there will be a new entry in the “Modules” section of the FS9 top menu labeled FSUIPC. FSUIPC can be configured to do many things – it really is a most versatile tool. However, for Plan-G, you do not need to know how it works or configure it at all.

With FS9 running, start the Plan-G program, Click the File tab and select the “Options” menu, and then the FS Connection tab.

The screen below is displayed.

The FS Connection Parameters dialogue (see Figure 88 below) can also be accessed by clicking the Launcher button (small diagonal arrow) in the Flight Simulator connections tab of the Home ribbon (below the Lock/Sync/Free buttons at the right).

The connection method is “Auto” by default. This can be left unchanged normally, but if you have problems connecting, select the FSUIPC option instead, as the connection method. The SimConnect settings in that window can be ignored.
Now close the Options window by clicking “OK”, and return to the main window. With FS loaded, press the “Connect” button. While Plan-G is connected to FS, the "Flight Simulator" caption under the Connect and Disconnect buttons on the Home ribbon will change to one of the following, according to the connection that has been made.

"FSX (SimConnect)"
"FSX (FSUIPC)"
"FS9 (FSUIPC)"

In the case of FS9, this will always via FSUIPC of course.

On connecting, the Plan-G map will move so that your FS9 aircraft location is shown, and a yellow User Aircraft Icon will appear. If AI aircraft are in the area, and as long as you have selected AI aircraft in the options panel to be displayed, they will appear in red. If you are connected to VATSIM, IVAO or another online server, then Plan-G displays other connected aircraft rather than AI aircraft.

You can now set up Trail Analysis, import FS Weather data etc. as described above, which significantly enhances the value of Plan-G.

If you get a connection error, or a connection time-out error, the most likely reason is that you have not selected the correct connection option, which must be FSUIPC, in the Global Options window. Less commonly, you may have set up FSUIPC incorrectly. Be sure to read the FSUIPC installation instructions. It has to be said, though, that FSUIPC is almost always trouble free in use, so the problem is most likely to be something you have done, or not done.

### 19.2 Connecting to FSX with SimConnect

SimConnect is the preferred connection option for FSX. It is efficient, fast, and provides optimal control over the information available. FSX users should be able to use FSX’s built-in SimConnect directly, but if that is not possible, then you can use the FSX version of Peter Dowson's FSUIPC - FSUIPC 4, which uses SimConnect internally.

FSUIPC 4 may be downloaded from [http://www.schiratti.com/dowson.html](http://www.schiratti.com/dowson.html) free of charge.

With Plan-G on the FSX PC, there is no setup required with SimConnect in FSX. However, in Plan-G, the SimConnect settings will need to be configured before a connection can be made.

First, decide which is the appropriate SimConnect data transfer protocol: - Pipe, IPv4 or IPv6. Remember:
• Pipe is used only internally in a PC, but is the fastest of the three.
• IPv4 is used by Windows Vista, XP and earlier versions of Windows.
• IPv6 is installed in Windows Vista and Windows 7, (though it may not be enabled) and may optionally be installed in Windows XP.

To configure the settings, select “Options” from the File Tab, then open the FS Connection tab. Check or amend the settings so that they correspond to one of the three configurations below (also shown in Figure 90, Figure 91 and Figure 92 below).

The FS Connection Parameters dialog (see Figure 90 below) can also be accessed by clicking the Launcher button (small diagonal arrow) in the Flight Simulator connections tab of the Home ribbon (below the Lock/Sync/Free buttons)

19.2.1 Connection Using Pipe

Set “Connect with” radio button to Auto

Network Mode: Select Pipe from the dropdown options.

FSX Computer: Enter either “localhost” or “127.0.0.1” (without quotes)

Server Port/Pipe: Leave blank (important)

![Figure 90 SimConnect Settings for a Single PC Using Pipe](image)

19.2.2 Connection Using IPv4

Set “Connect with” radio button to Auto

Network Mode: Select IPv4 from the dropdown options.

FSX Computer: Enter either “localhost” or “127.0.0.1” (without quotes)

Server Port/Pipe: Enter “0” (Without quotes)
19.2.3 Connection Using IPv6

Set “Connect with” radio button to Auto

Network Mode: Select IPv6 from the dropdown options.
FSX Computer: Enter either “localhost” or “::1” (without quotes)
Server Port/Pipe: Enter “0” (Without quotes)

As long as you set up Plan-G as described here, it is unlikely that you will have any difficulty connecting to FSX from Plan-G on a single computer.

Close the Options window by clicking “OK”, and return to the main window. With FSX running, press the “Connect” button. Note that the label below the Connect/Disconnect buttons changes to identify which Simulator version you are connected to, and how. It should indicate that you are connected to FSX via SimConnect.

On connecting, the Plan-G map will move so that your FSX aircraft location is shown, and a yellow User Aircraft Icon will appear. If AI aircraft are in the area, and as long as you have selected AI aircraft in the options panel to be displayed, they will appear in red. If
you are connected to VATSIM, IVAO or another online server, then Plan-G displays other connected aircraft rather than AI aircraft.

You can now set up Trail Analysis, import FS Weather data etc. as described above, which significantly enhances the value of Plan-G.

If you get a connection error, or a connection time-out error, the most likely reason is that you have not configured Plan-G with the correct SimConnect parameters in the Global Options window. Section 21 below deals with addressing SimConnect problems. If the advice in that section does not result in SimConnect successfully connecting, the problem may be tricky to solve. If you have other programs which use SimConnect and you are unsure of how to correct SimConnect problems, please do not experiment, but seek expert advice.

19.3 Connecting to FSX with FSUIPC

If using SimConnect does not work for you, (SimConnect can be troublesome on some computers, and solving the problem is not trivial, unfortunately) then use the FSX version of Peter Dowson’s FSUIPC. This is FSUIPC 4 which uses SimConnect internally, and may be downloaded from http://www.schiratti.com/dowson.html free of charge.

Peter Dowson provides very friendly and attentive support for his programs on this forum:

The FSUIPC4 installer program copies a file called “FSUIPC4.DLL” into the FSX/Modules folder, along with the FSUIPC4 User Guide.pdf. When you next run FSX, after accepting the newly-installed FSUIPC4 modules, there will be a new FSUIPC entry in the “Add-Ons” menu. FSUIPCs first action will be to ask you to register the program. If you simply want to use FSUIPC4 to connect FSX to add-on programs on the same PC, you do not have to continue with registration of the program.

Now, start Plan-G. In the Global Options FS Connection tab, select “FSUIPC” as the connection method. There is no need to change any of the other parameters; they are not used.

If all is well, close the Options window by clicking “OK”, and return to the main window. Now press the “Connect” button. Note that the label below the Connect/Disconnect buttons changes to identify which Simulator version you are connected to, and how. In the case of FSX, this can be SimConnect, but check that in this case it is showing Connected via FSUIPC.

On connecting, the Plan-G map will move so that your FSX aircraft location is shown, and a yellow User Aircraft Icon will appear. If AI aircraft are in the area, and as long as you have selected AI aircraft in the options panel to be displayed, they will appear in red. If you are connected to VATSIM, IVAO or another online server, then Plan-G displays other connected aircraft rather than AI aircraft.
You can now set up Trail Analysis; import FS Weather data etc. as described above, which significantly enhances the value of Plan-G.

If you get a connection error, or a connection time-out error, the most likely reason is that you have not selected the correct connection option, which **must** be FSUIPC, in the Global Options window. Less commonly, you may have set up FSUIPC incorrectly. Be sure to read the FSUIPC installation instructions. It has to be said, though, that FSUIPC is almost always trouble free in use, so the problem is most likely to be something you have done, or not done.
20 **FLIGHT SIMULATOR AND PLAN-G ON A NETWORK**

You can install Plan-G on a second PC (the “Network PC”) that is connected to the FS PC through a home TCP/IP network, either wirelessly (WiFi, IEEE 802.11a/b/g/n) or wired via Ethernet. Firstly, follow the steps in the Prerequisites and Installation sections of this manual (sections 3 and 4) to install Plan-G on the Network PC. It does not need to be installed on the FS PC.

Firewall software must be configured to allow TCP communications on the port you set below – this includes Windows Firewall and any router firewall – and applies to both computers, FS PC and Network PC.

FSX users can choose between using SimConnect, or using Peter Dowson's FSUIPC4 program, the same choice (and for the same reason) as connecting on a single PC – i.e. SimConnect may not always work, and finding out why isn’t always easy, whereas FSUIPC almost always works. However, SimConnect is the preferred connection option for FSX. It is more efficient, faster, and provides optimal control over the information available.

20.1 **First Find Your Sim**

Section 8.5.1 above describes how to set up the locations in Plan-G so that it knows where to get its Flight Simulator data. This must be done before attempting connect the Sim to Plan-G, whether it be FS9 or FSX.

20.2 **Connecting to FS9 from a Networked PC**

FS9 users will have to install Peter Dowson's free FSUIPC (“Flight Simulator Universal Inter-Process Communication”) program

http://www.schiratti.com/dowson.html

on the FS9 PC to be able to connect to Plan-G.

You will also need to buy Peter Dowson’s WideFS and use it with either with the freeware FS9 version of Peter Dowson's FSUIPC - FSUIPC 3, or you can, if you wish, buy the full featured version of FSUIPC 3.

FSUIPC 3 may be downloaded from http://www.schiratti.com/dowson.html

Peter Dowson provides very friendly and attentive support for his programs on this forum:


The FSUIPC3 installer program copies a file called “FSUIPC.DLL” into the FS9/Modules folder, along with the FSUIPC User Guide.pdf. When you next run FS9, after accepting the newly-installed FSUIPC modules, there will be a new FSUIPC entry in the “Add-Ons” menu. FSUIPCs first action will be to ask you to register the program. If you simply want to use FSUIPC3 to connect FS9 to add-on programs on the same PC, you do not have to continue with registration of the program.
20.2.1 WideFS

In addition, you will need a second Peter Dowson program called WideFS, which installs a server portion, WideServer.dll, on the FS9 PC, and a client portion, WideClient.exe, on the Network PC. WideFS is available from

http://www.schiratti.com/dowson.html

Note that, in contrast to FSUIPC, WideFS is not free, and must be purchased and registered, using an access key. There is an option to buy the registered version of FSUIPC and WideFS as a bundle, which costs less than the two purchased separately. Note that for FS9 you must buy the FS9 specific version.

Follow the instructions in the WideFS User Guide (a pdf document) to install the client and server portions along with their configuration files (WideServer.ini on the FS9 PC, and WideClient.ini on the Network PC). The two .ini configuration files have to be edited to match your two PC names and IP addresses.

One of the WideFS installation options is to place an icon on your desktop. This is strongly recommended that you do that so that you don’t forget to start it whenever you want to run FS9 and Plan-G on separate PCs.

20.2.2 Connection Steps

After the installation and configuration of FSUIPC and WideFS, you will be able to run FS9 on the FS9 PC, and Plan-G on the Network PC. There is just one extra step in the procedure than for connecting on the same PC.

1. Start FS9. Note that in the top frame of the FS9 Window you will see the words “FS2004 with Wideserver: Waiting for clients”. This is your indication that the WideFS server module is working.

2. Start Wideclient on the Plan-G PC – from the desktop icon if you have one. You won’t see anything happen except a blank grey screen opens (unless you have configured it to start minimized. If you maximize the Wideclient window from the taskbar, you will see the word “Connected” in the top frame of the window. That is your indication that Wideclient is working. You can now minimize Wideclient to the taskbar again. Once you become familiar with WideFS you will almost forget about it as it works silently and reliably in the background.

3. Start Plan-G

4. In the Global Options FS Connection tab of Plan-G, select “FSUIPC” as the connection method.

5. Return to the main screen in Plan-G and click the “Connect” button. After a few seconds, you will hear a “Connected!” sound from the Network PC, and the Connect/Disconnect buttons will show that you are connected.
In the FS9 window top frame, the wording will now have changed to *FS2004 with Wideserver: 1 connected*.

All the additional data features mentioned above for connecting to FS will be available in an identical way to connecting with only one PC, and it is highly unlikely that you will experience any loss of FS9 performance.

### 20.3 Connecting to FSX from a Networked PC with SimConnect

There are three steps required to connect the two PCs with SimConnect. Don’t be put off by the seemingly technical instructions which follow – The procedure is actually quite easy:

- Decide the appropriate data transfer protocol (see section 18.2 above). Note that Pipe does not work across a network.
- Create or modify a special file “SimConnect.xml” on the FSX PC
- Configure the SimConnect parameters in Plan-G to match those in SimConnect.xml.

**Note:** You do not need to build a SimConnect.xml file if you are running FSX and Plan-G on the same PC.

#### 20.3.1 Creating a SimConnect.xml file for the IPv4 Protocol

This file must be created on the FSX PC, in the same folder as fsx.cfg.

For Windows XP users, this is usually

C:\Documents and Settings\<user name>\Application Data\Microsoft\FSX

For Windows Vista users, this is usually

C:\Users\<Username>\AppData\Roaming\Microsoft\FSX.

SimConnect.xml is a text file which you can create using Windows NotePad or any simple text editor (not MSWord). Plan-G will not build a SimConnect.xml file for you.

The following is an example which has been proved to work for two networked Windows XP machines. The red coloured text will not change in any SimConnect file. The blue coloured text is the part which you may need to change to suit your set up.

```xml
<?xml version="1.0" encoding="Windows-1252"?>
<SimBase.Document Type="SimConnect" version="1,0">
    <Descr>SimConnect</Descr>
    <Filename>SimConnect.xml</Filename>
</SimBase.Document>
```
The example above includes two “profiles” (the blue coloured code between `<SimConnect.Comm>` and `</SimConnect.Comm>`). One is configured for an “Auto” connection, the other for an IPv4 connection. If you choose to use the example above, then usually, only the computer address (in bold) needs to be changed to match your FSX PC’s IP address. In most networks nowadays, the router’s IP Address is 192.168.0.1 and the PCs have 192.168.0.2, 192.168.0.3 etc. but beware – occasionally default IP addresses are different, so do check.

The Port value – 4506 – need only be changed from the example above, if you have an existing SimConnect.xml file and you see that Port 4506 is already in use. Changing it in that case for Plan-G to 4505 is quite sufficient, but don’t forget to make the same change in the Plan-G Global Options->FS Connection window. The range of port values which you can use is from 4500 to 4510 inclusive.

### 20.3.2 Creating a SimConnect.xml file for the IPv6 Protocol

Remember that IPv6 is installed in Windows Vista and Windows 7 by default, (though it may not be enabled) and may optionally be installed in Windows XP. See the link at the end of this section for further information.

The SimConnect file must be created on the FSX PC, in the same folder as fsx.cfg.

This is usually

**C:\Program Data\Microsoft\FSX**

SimConnect.xml is a text file which you can create using Windows NotePad or any simple text editor (not MSWord). Plan-G will not build a SimConnect.xml file for you.
The following is an example which has been proved to work for two networked Windows 7 machines. The red coloured text will not change in any SimConnect file. The blue coloured text is the part which you may need to change to suit your set up.

```xml
<?xml version="1.0" encoding="Windows-1252"?>
<SimBase.Document Type="SimConnect" version="1,0">
  <Descr>SimConnect</Descr>
  <Filename>SimConnect.xml</Filename>
  <SimConnect.Comm>
    <Disabled>False</Disabled>
    <Protocol>IPv6</Protocol>
    <Scope>link-local</Scope>
    <MaxClients>64</MaxClients>
    <Address>fe80::899d:395:c919:168f</Address>
    <Port>4506</Port>
  </SimConnect.Comm>
</SimBase.Document>
```

The example above includes just one “profile” (the blue coloured code between <SimConnect.Comm> and </SimConnect.Comm>). If you choose to use the example above, then usually, only the computer address (in bold) needs to be changed to match your FSX PC’s IP address. To find your Windows 7/Vista computer’s IP address:

- On the Start menu, right-click on ‘Network’
- Select properties, then click on the active connection (‘Local Area Connection’ or ‘Wireless Connection’ for example.
- This brings up the ‘Connection Status’ dialog. Click on ‘Details’ and all your parameters are listed, including the IPv6 address, which always starts ‘fe’.

The Port value – 4506 – need only be changed from the example above, if you have an existing SimConnect.xml file and you see that Port 4506 is already in use. Changing it in that case for Plan-G to 4505 is quite sufficient, but don’t forget to make the same change in the Plan-G Global Options->FS Connection window. The range of port values which you can use is from 4500 to 4510 inclusive.

Technical Note: IPv6 addresses are 128-bit hexadecimal numbers. Each pair of bytes (octets) is separated by a colon, viz: ab32:12cd. But they can be shorthanded so you would rarely have to write out the full string.

- Leading Os in a pair can be omitted (:34d: is the same as :034d:)
- Pairs that are all-0s can be omitted (E3D7:0000:0000:0000:51F4 can be written as E3D7::51F4), but you can only do that once per ip
- Site-Local (fec* through fef*) is the IPv6 equivalent to the IP4 192.168.. and 10.0... private subnets, ie they are not propagated onto the Internet. They will pass through routers, so can span an entire organisation.
- Link-Local (fe8* through fef*) are also private addresses (like 192.168 etc) that don't get propagated to the Internet, BUT they restricted to a single LAN, so they will not pass through a router.
There is a checksum at the end of the address (%11, or %13 etc). This does not form part of the address.

More information about IPv6 is available at http://ipv6int.net/systems/windows_xp-ipv6.html

### 20.3.3 Modifying an Existing a SimConnect.xml file

It is strongly recommended that you make a copy of the existing file on your computer before you modify it. The code in blue above should then be added to the existing file just before the final

</SimBase.Document>

Do not copy the code in red into the existing file – once is enough! Save the file. Again if you choose to use the example above, then only the computer address (in bold) needs to be changed to match your FSX PC’s IP address.

Other examples are given in Section 21 below, with more detailed explanation, should you be interested.

If you don’t wish to get as technical as this, simply ask for help on the very active Plan-G Forum. There are Techies by the score there who will be only too willing to answer all your questions.

### 20.3.4 Configure the SimConnect Settings in Plan-G

Once you have the SimConnect.xml file created on the FSX PC, you can configure Plan-G on the Network PC to “find” the FSX data on the networked PC. In the Plan-G program, select the Global Options menu, the FS Connection tab. Select “Auto”, preferably, or “SimConnect” as the connection method.

The SimConnect Settings should be set as described below and shown in Figs. 10.02 & 10.03 below.

**Network Mode:** IPv4

**FSX Computer:** IP address (e.g. 192.168.0.2) or computer network name

**Server Port/Pipe:** 4506

![Figure 96 A SimConnect Configuration for IPv4 with Windows XP](image-url)
In Figure 96 above, the corresponding SimConnect profile would be

```xml
<SimConnect.Comm>
  <Disabled>False</Disabled>
  <Protocol>IPv4</Protocol>
  <Scope>global</Scope>
  <Address>192.168.0.2</Address>
  <MaxClients>64</MaxClients>
  <Port>4506</Port>
  <MaxRecvSize>4096</MaxRecvSize>
  <DisableNagle>False</DisableNagle>
</SimConnect.Comm>
```

Network Mode: IPv6
FSX Computer: IPv6 address, e.g. fe80::899d:395:c919:168f
Server Port/Pipe: 4506

![Figure 97 A SimConnect Configuration for IPv6 with Windows 7](image)

In Figure 97 above, the corresponding SimConnect profile would be

```xml
<SimConnect.Comm>
  <Disabled>False</Disabled>
  <Protocol>IPv6</Protocol>
  <Scope>link-local</Scope>
  <Address>fe80::899d:395:c919:168f</Address>
  <MaxClients>64</MaxClients>
  <Port>4506</Port>
  <MaxRecvSize>4096</MaxRecvSize>
  <DisableNagle>False</DisableNagle>
</SimConnect.Comm>
```
**Note:** Link-local is an IPv6 mechanism for accessing computers on a network that does not involve traversing a router. It is **required** for link-local IP6 addresses (which start fe80:....)

### 20.3.5 Connected

Close the Options window by clicking “OK”. Now press the “Connect” button.

![Figure 98 Connected to FSX](image)

After all the above, you may feel that you have achieved a minor miracle. The good news is that, hopefully, you only have to go through that process once, unless you re-install FSX or something equally drastic. If the user is connected to VATSIM, IVAO or other online or multiplayer server, then Plan-G displays other connected aircraft rather than AI aircraft.

On connecting, the Plan-G map will move so that your FSX aircraft location is shown, and a yellow User Aircraft Icon will appear. If AI aircraft are in the area, and as long as you have selected AI aircraft in the options panel to be displayed, they will appear in red. If the user is connected to VATSIM, IVAO or another online server, then Plan-G displays other connected aircraft rather than AI aircraft.

You can now set up Trail Analysis, import FS Weather data etc. as described above, which significantly enhances the value of Plan-G.

If you get a connection error, or a connection time-out error, the most likely reason is that you have not configured Plan-G with the correct SimConnect parameters in the Global Options window. Section 21 below deals with addressing SimConnect problems. If the advice in that section does not result in SimConnect successfully connecting, the problem may be tricky to solve. If you have other programs which use SimConnect and you are unsure of how to correct SimConnect problems, please do not experiment, but seek expert advice.

### 20.4 Connecting to FSX from a Networked PC with FSUIPC

SimConnect is the preferred connection option for FSX. It is more efficient, faster, and provides optimal control over the information available. FSX users should be able to use FSX's built-in SimConnect by carefully following the instructions in this manual, but if you cannot get it to work for you, then you will need to buy Peter Dowson’s WideFS and use it with either the freeware FSX version of Peter Dowson's FSUIPC - FSUIPC 4, which uses SimConnect internally, or you can, if you wish, buy the full featured version of FSUIPC 4.

FSUIPC 4 may be downloaded from [http://www.schiratti.com/dowson.html](http://www.schiratti.com/dowson.html)
Peter Dowson provides very friendly and attentive support for his programs on this forum:


The FSUIPC4 installer program copies a file called “FSUIPC4.DLL” into the FSX/Modules folder, along with the FSUIPC4 User Guide.pdf. When you next run FSX, after accepting the newly-installed FSUIPC4 modules, there will be a new FSUIPC entry in the “Add-Ons” menu. FSUIPCs first action will be to ask you to register the program. If you simply want to use FSUIPC4 to connect FSX to add-on programs on the same PC, you do not have to continue with registration of the program.

20.4.1 WideFS

In addition, you will need a second Peter Dowson program called WideFS, which installs a server portion, WideServer.dll, on the FSX PC, and a client portion, WideClient.exe, on the Network PC. WideFS is available from:

http://www.schiratti.com/dowson.html

Note that, in contrast to FSUIPC, WideFS is not free, and must be purchased and registered, using an access key. There is an option to buy the registered version of FSUIPC (which has many more features than the free version) and WideFS as a bundle, which costs less than the two purchased separately. Note that for FSX you must buy the FSX specific version.

Follow the instructions in the WideFS User Guide (a pdf document) to install the client and server portions along with their configuration files (WideServer.ini on the FSX PC, and WideClient.ini on the Network PC). The two .ini configuration files have to be edited to match your two PC network names and IP addresses.

One of the WideFS installation options is to place an icon on your desktop. It is strongly recommended that you do so, so that you don’t forget to start it whenever you want to run FSX and Plan-G on separate PCs (a very common user error).

20.4.2 Connection Steps

After the installation and configuration of FSUIPC and WideFS, you will be able to run FSX on the FSX PC, and Plan-G on the Network PC. There is just one extra step in the procedure than for connecting on the same PC.

1. Start FSX. Note that in the top frame of the FSX Window you will see the words FSX with Wideserver: Waiting for clients. This is your indication that the WideFS server module is working.

6. Start Wideclient on the Plan-G PC – from the desktop icon if you have one. You won’t see anything happen except a blank grey screen opens (unless you have configured it to start minimized. If you maximize the Wideclient window from the taskbar, you will see the word “Connected” in the top frame of the window. That is your indication that Wideclient is working. You can now minimize Wideclient to the taskbar again. Once you become familiar with WideFS you will almost forget about it as it works silently and reliably in the background.

7. Start Plan-G
8. In the Global Options FS Connection tab of Plan-G, select “FSUIPC” as the connection method.

9. Return to the main screen in Plan-G and click the “Connect” button. After a few seconds, you will hear a “Connected!” sound from the Network PC, and the Connect/Disconnect buttons will show that you are connected.

In the FSX window top frame, the wording will now have changed to *FSX with Wideserver: 1 connected.*

All the additional data features mentioned above for connecting to FS will be available in an identical way to connecting with only one PC, and it is highly unlikely that you will experience any loss of FSX performance. In the FSX window top frame, the wording will now have changed to *FSX with Wideserver: 1 connected.*

All the additional data features mentioned above for connecting to FS will be available in an identical way to connecting with only one PC, and it is highly unlikely that you will experience any loss of FSX performance.

![Figure 99 FSX Connected via FSUIPC](image-url)
21 MORE ON SIMCONNECT

Microsoft's SimConnect is software that communicates FSX flight information to another 
Windows program (Plan-G in our case). See 


for an introduction to SimConnect.

All versions of FSX (Basic and Deluxe, the original RTM version, SP1 and SP2) incorporate 
the SimConnect server interface. However, each release uses its own version of the 
SimConnect client (simconnect.dll), which is only distributed with the Deluxe version of 
the FSX program, in the FSX Software Development Kit (SDK). The SDK can be found on 
the Deluxe edition, DVD 1.

You do not need to install the SimConnect client, in fact you need do nothing technical 
with it apart from creating a SimConnect.xml file, because Plan-G includes a version of 
the SimConnect Client created by Tim Gregson, formerly of Microsoft Aces, which seems 
to be more robust than the original.

SimConnect requires a “script” in order to know what to do. This script is called 
SimConnect.xml and resides on your FSX PC in the same folder as FSX.CFG. The 
structure of SimConnect.xml files may look quite awesome to people not familiar with 
modern script computer languages. Here are a few simple rules about this file and xml 
in general.

1. There is no error trapping. Make a typing error and it simply won’t work – but it 
won’t crash your computer either.

2. All space characters and new lines are ignored so you can have as many as you 
like.

3. Every Command opening tag <tag> must have an equivalent closing tag 
</tag>

4. Each “Profile” of the file, defining a different protocol, starts 
<SimConnect.Comm> and ends </SimConnect.Comm> so you can see in 
the examples below several such “Profiles” in the one file.

5. The whole file must start with the header (in red in examples below) and end 
with the closing tag (also in red)

6. The opening tag <!-- and the closing tag --> enclose text which is ignored, so you 
can put any comment you like between those tags to explain to yourself when 
looking at the code years later, what it means.

7. If you get it wrong you cannot harm your PC. But do seek expert help if 
necessary to avoid hours of frustration.

There are three data transfer protocols which may be used, Pipe, IPv4 and IPv6. 
Pipe is normally used for internal communications within a PC. 
IPv4 is used by Windows XP by default, and earlier versions of Windows.
IPv6 is available in Windows Vista and Windows 7, and may be installed in Windows XP if you wish.

You need to Enable the one you want to use by making sure the line:

```xml
<Disabled>False</Disabled>
```

is present. For the other Elements, you can change the line to:

```xml
<Disabled>True</Disabled>
```

but this isn’t essential. Plan-G will use the protocol set in Global Options.

For IPv6 connections. Note that `<Scope>` needs to be set to *link-local* not *global*

### 21.1 Example 1

This example contains four “Profiles”, one for a local pipe connection, two for remote (network) IPv6 connections and one for a remote IPv4 connection. Note that the Pipe protocol cannot be used for networked connections.

```xml
<!-- Example Local Pipe Server Configuration-->
<?xml version="1.0" encoding="Windows-1252"?>
<SimBase.Document Type="SimConnect" version="1,0">
  <Descr>SimConnect Server Configuration</Descr>
  <Filename>SimConnect.xml</Filename>
  <Disabled>False</Disabled>
  <SimConnect.Comm>
    <Disabled>False</Disabled>
    <Protocol>Pipe</Protocol>
    <Scope>local</Scope>
    <MaxClients>64</MaxClients>
    <Port></Port>  /*THE PORT IS GIVEN NO VALUE*/
  </SimConnect.Comm>

<!-- Example Global (remote) IPv6 Server Configuration-->
<SimConnect.Comm>
  <Disabled>False</Disabled>
  <Protocol>IPv6</Protocol>
  <Scope>link-local</Scope>
  <MaxClients>64</MaxClients>
  <Address>fe80::5974:d93:646d:a902</Address>
  <Port>4506</Port>
</SimConnect.Comm>

<!--2nd Example Global (remote) IPv4 Server Configuration-->
<SimConnect.Comm>
  <Disabled>False</Disabled>
  <Protocol>IPv4</Protocol>
  <Scope>link-local</Scope>
</SimConnect.Comm>
```
21.2 Example 2

The example below includes profiles for two remote and three local connections, for Pipe, IPv6 and IPv4 connections. For remote connections, i.e. a network connection, you would need to enable one or more of the three "Global" profiles in the SimConnect.xml file.

To enable a profile, set "Disabled" to false:

```
<Disabled>False</Disabled>
```

and then specify the IPv4/IPv6/machine name and port number/pipe name in the appropriate sections.
Instead of 127.0.0.1 in the last profile of Example 2 you can enter the name localhost. Either is valid.
22 APPENDIXES

22.1 Appendix 1 Table of Illustrations

Figure 1 The Plan-G User Interface at Startup ................................................................. 4
Figure 2 Database Build Options ..................................................................................... 6
Figure 3 The Standard Google Maps Tools are used ....................................................... 7
Figure 4 Quick Access Toolbar ...................................................................................... 7
Figure 5 The ‘Customise Quick Access Toolbar’ Dropdown ........................................... 8
Figure 6 The Menu Tabs ................................................................................................. 8
Figure 7 The File Menu Page ......................................................................................... 10
Figure 8 The Home Ribbon ........................................................................................... 10
Figure 9 The Map Ribbon ............................................................................................... 11
Figure 10 Data Ribbon .................................................................................................. 11
Figure 11 The View Ribbon ............................................................................................ 11
Figure 12 The ‘Minimise Ribbon’ icon and Tooltip ....................................................... 12
Figure 13 The File Options ............................................................................................ 14
Figure 14 The Locations Page ....................................................................................... 15
Figure 15 Browsing for the Location of FSX ................................................................. 16
Figure 16 FSX and FS9 Locations using Mapped Network Drives .................................. 18
Figure 17 The Units Page ............................................................................................... 19
Figure 18 Sounds Page .................................................................................................. 20
Figure 19 FS Connections Page .................................................................................... 20
Figure 20 GPS Panel Configuration Page ..................................................................... 21
Figure 21 User Aircraft Options ..................................................................................... 23
Figure 22 Traffic Options ............................................................................................... 24
Figure 23 Weather Parameters ....................................................................................... 24
Figure 24 Using the Find Function to Locate an Airport ............................................... 25
Figure 25 Start Position Window .................................................................................... 26
Figure 26 Cruising Altitude Window ............................................................................. 27
Figure 27 Cruising Airspeed Window .......................................................................... 27
Figure 28 KML Dialogue Window ............................................................................... 29
Figure 29 The Map Ribbon ........................................................................................... 31
Figure 61 Right-Click Dropdown - Start Flight Plan from Here .......................... 56
Figure 62 Using the Find Function to Locate an Airport ............................. 56
Figure 63 Right-click Dropdown - Add Waypoint to Plan .......................... 57
Figure 64 Move your Aircraft, but not to the Active! ............................... 57
Figure 65 Adding a Waypoint .................................................................. 59
Figure 66 Vertical Navigation Profile Diagram ........................................ 60
Figure 67 Inserting a Waypoint ............................................................... 61
Figure 68 Drag Handles in Edit Mode (Highlighted here in Red Circles) .... 62
Figure 69 The User Waypoint Database .................................................. 64
Figure 70 User Waypoint Dropdown ........................................................ 64
Figure 71 Create User Waypoint Dialogue ............................................. 65
Figure 72 User Waypoint Created ............................................................ 65
Figure 73 User Waypoint Added to Database .......................................... 66
Figure 74 Add User Waypoint to Flight Plan ........................................... 66
Figure 75 Editing a User Waypoint ......................................................... 67
Figure 76 Editing The User Waypoint Database ..................................... 68
Figure 77 User Defined Records Imported ............................................. 68
Figure 78 Carlisle to Liverpool - The Route .......................................... 69
Figure 79 Over the Lakeland Hills ........................................................... 71
Figure 80 Sellafield and Eskmeals “Don’t Go There” Areas .................... 72
Figure 81 Controlled Airspace (Red Lettering not in Plan-G) ................... 74
Figure 82 Seaforth VRP Deleted from the Plan ....................................... 75
Figure 83 Instrument Approach and Route to Alternate ......................... 75
Figure 84 VNAV Profile is the Orange Line ............................................ 76
Figure 85 The Completed Plan ............................................................... 77
Figure 86 Forney Aircoupe G-ARHC Over Derwentwater ..................... 78
Figure 87 Connected to FS, Plan-G can display a lot of valuable data ... 80
Figure 88 Global Options FS Connection Tab ....................................... 82
Figure 89 Connected to FS9 with FSUIPC ........................................... 83
Figure 90 SimConnect Settings for a Single PC Using Pipe ................... 84
Figure 91 SimConnect Settings for a Single PC Using IPv4 .................... 85
Figure 92 SimConnect Settings for a Single PC Using IPv6 .................... 85
22.2 Appendix 2 – Support

Please go to http://www.tasoftware.co.uk/forum

Email Contact
tim@tasoftware.co.uk

22.3 Appendix 3 – Solve the Script Error Issue

The “Script Error” problem mentioned in Section 12, is caused by a Windows internal timer which times out if script processing takes longer than a preset value. You can change this time-out value – make it longer – to reduce or avoid those annoying messages, but it needs a manual intervention in the Registry.

Altering Registry values can cause severe problems to your computer, so only try this if you are familiar with the Registry. Familiar, experienced, or novice, ALWAYS make a backup copy of the Registry before starting to tinker.

To change this time-out value in Internet Explorer 4.0, 5.0, 6, 7, or 8, follow these steps:

1. Using a Registry Editor such as Regedt32.exe, open this key:
   
   HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Styles

   Note If the Styles key is not present, create a new key that is called Styles.

2. Create a new REG-DWORD value called "MaxScriptStatements" under this key and set the value to the desired number of script statements. If you are unsure of what value you need to set this to, you can set it to a DWORD value of 0xFFFFFFFF to completely avoid the dialog.

3. However, timers exist for good safety reasons, and it is probably more prudent to set the value to something sensible. A value of 0x00FFFFFF has been demonstrated to work quite successfully, although it does not eliminate script errors completely.

An alternative solution is to go to the MS support page on this subject http://support.microsoft.com/default.aspx?scid=kb;en-us;Q175500
And click on the 'Fix It' button. It's a much easier option if you don’t mind people tinkering with the innards of your PC from afar!

22.4 Appendix 4 - List of Beta Testers

Many people have contributed to testing Plan-G, but the ones below deserve a special mention for the very significant contribution they have made over a long period.

| Adam Micheals,          | Jeff Schallenberg,               |
| Alex Feldstein,        | Joe Morrison,                    |
| bman (Benjamin),       | Ken Alger,                      |
| Claude Bouissiere,     | Ken Pratt,                       |
| Dave Belsey,           | Norman Dean,                    |
| Don Fraser,            | Paul Donnelly,                  |
| Edge,                  | Peter Dodds,                    |
| Fenric,                | Pete Allnutt,                   |
| Frank Turley,          | Roddymod,                       |
| Gary Shaw,             | Ruth McTighe,                   |
| Geoff Cooper,          | Tom Earl,                       |
| Geoffrey Shipton,      | Thomas Hawk,                    |
| gdawg (Gary),          | Vic Baron                       |
| Glen Coyne,            |                                |

Document Ends